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Chapter 1: Introduction 

Who Should Read This Guide 
This guide is intended for those responsible for installing and setting up 
SolarWinds Cirrus Configuration Management version 2.  This will normally be 
the system/network administrator.  The Windows account used to install Cirrus 
will need to have administrative rights on the server. 

What’s Covered in This Guide 
This guide includes sections that discuss 

• Installation and setup 
• Adding Nodes and getting started 
• Scheduling tasks 
• Performing inventory scans 
• Modifying and comparing configs 
• Creating and editing reports 

Overview of Cirrus 
Cirrus Configuration Management is a powerful application providing the 
network engineer with a quick and efficient method of managing the 
configurations of network devices: Routers, Switches, VPN Concentrators, 
Wireless Access Points, Firewalls, etc. Cirrus is a highly advanced, yet easy-to-use 
application designed to streamline and automate routine network configuration 
management tasks such as: 

• Scheduled Back Ups of configs  
• Ability to make Bulk Changes  
• Updating access lists  
• Device Inventory  
• Changing SSIDs on Access Points  
• Altering community strings for a group of routers or switches  
• Ability to roll out Mass Config Changes  
• Config Comparisons 

Cirrus Configuration Management is available in two different versions; Desktop 
and Enterprise. The Desktop Edition is for stand-alone use on a laptop or desktop 
by one user. The Desktop Edition is limited to managing 25 network Nodes.  
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The Enterprise Edition can be used in a stand-alone or workgroup environment 
with multiple users. The Enterprise Edition is scalable and is available in packages 
from 50 Nodes to an unlimited number of managed Nodes. Many features (such 
as SQL Server support, Device Inventory, and integrated MIB Browser) are only 
available in the Enterprise Edition. 

Cirrus Configuration Management supports many types of network devices from 
many hardware vendors.  Device Command Templates for Cisco, Foundry, Dell, 
HP Juniper, Motorola, Arris and many others are included. 

Cirrus Configuration Management includes detailed Device Inventory. The 
inventory includes interface and port details, IP Addresses, information about 
ARP tables, cards in each slot, firmware levels and much more. The information 
can be easily extracted and used by other applications. 
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How to Contact SolarWinds.Net 

The SolarWinds website is an excellent resource located at 
http://www.SolarWinds.Net.  If more information is needed, please do not hesitate 
to contact a SolarWinds representative. 

Support 

Visit the Support website at http://SolarWinds.Net/Support/index.htm to access 
the Knowledge Base, Frequently Asked Questions, obtain Program Updates, 
contact the Support Team, provide feedback, visit the User Forum, and more! 

E-Mail 

The SolarWinds Support Team can be E-Mailed at Support@SolarWinds.Net. 

Sales 

Send e-mail to a Sales representative at Sales@SolarWinds.Net for any sales needs. 

Mail 

SolarWinds.Net 
8221 East 63rd Place 
Tulsa, OK 74133 USA 

http://www.SolarWinds.Net
http://SolarWinds.Net/Support/index.htm
mailto:Support@SolarWinds.Net
mailto:Sales@SolarWinds.Net




 

   

Chapter 2: Installation & Setup 
This chapter will walk through the installation process for Cirrus.  Installation 
proceeds in 3 steps: 

• Installing Microsoft SQL Server 
• Installing Cirrus 
• Running the Startup Wizard 

Licensing and Version Options 
Cirrus is available in four different packages: 

Desktop Enterprise  
DL25 DL50 DL100 DL200 DL500 DL1000 DLX 

Maximum 
number of 
Nodes that 
can be 
managed 

25 50 100 200 500 1000 No 
Limit 

Database 
Format Access 

SQL or 
Access 

SQL or 
Access 

SQL or 
Access 

SQL or 
Access 

SQL or 
Access 

SQL or 
Access 

System Requirements 
The System Requirements for Cirrus vary based upon the number of Nodes, 
frequency of config downloads, how long configs are maintained in the database, 
and several other factors.  The table below represents some general guidelines for 
a minimum configuration. 

 Minimum System Requirements 

Operating System Windows 2000 Server with Service Pack 4 
Windows 2003 Server with Service Pack 1 
Windows XP Professional with Service Pack 2 

CPU Intel Pentium 3 (or equivalent) - 800 MHz or higher 

Memory 256 MB of RAM 

Hard Drive Space 1 GB of space available 
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Step 1: Installing SQL Server 

¤  Installing SQL Server is NOT required to run Cirrus.  Both the Desktop and Enterprise 
versions can support an Access database. 

A licensed copy of Microsoft SQL Server 2000 Desktop Engine (MSDE) is 
distributed with each copy of Cirrus.  MSDE supports a maximum database size 
of 2GB.  Depending on how the tool is used, it may be necessary to acquire and 
install either the Standard or the Enterprise version of SQL Server.  MSDE may be 
installed from the CD or by logging into the customer area of the SolarWinds.Net 
website and downloading Cirrus. 

¤  SQL Server installation defaults are specified in the SETUP.INI file.  If SQL Server needs to be 
installed anywhere but the default location, or logging needs to be enabled for 
troubleshooting, this file can be modified once it is saved to the hard drive.  More information 
about installation options can be found on Microsoft’s website at 
http://www.microsoft.com/sql. 

Step 2: Installing Cirrus 
1. Begin the Installation of Cirrus from either the CD or the download 

file. 

2. Choose the target directory where for the Cirrus installation.  The 
default is C:\Program Files\SolarWinds\. 

3. Follow the steps of the Installation Wizard and if prompted to do so, 
restart the computer. 

¤  If prompted to install the Software License Key, please follow the instructions in Appendix A: 
Software License Key on page 131. 

Step 3: Configuration and Setup 
After installing Cirrus, it will be necessary to run the Startup Wizard to continue 
the installation and setup process.  The Wizard will configure connectivity to the 
database and establish the default settings such as the Global Community String, 
Username, Password, Enable Level, and more. 

The two database formats supported by Cirrus are Microsoft Access and SQL 
Server 2000.  The Desktop package only supports the Microsoft Access database 
format, and the Enterprise packages include additional support for SQL Server. 

http://www.microsoft.com/sql
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To begin, 

1. Open SolarWinds Cirrus Configuration Management from the 
Windows Start menu: Start à  SolarWinds Configuration Management à  
Configuration Management. 

 

2. Click the Startup Wizard button in the middle of the Quick Start page, or 
select New/Open Database Wizard from the File menu. 

3. Click Next à  on the Welcome screen to begin the Wizard. 

 

4. Ensure that Create a New Database is selected and then click Next à  to 
open the New Configuration Management Database dialog. 
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Creating a Microsoft Access Database 

1. Select Microsoft Access Database at the top of the dialog. 

 
2. The options at the bottom change to display a drop-down text box 

prompting for a filename.  Type a path and filename for the new 
database, or use the Ellipsis  button to browse to a location.  Once 
satisfied with the path and filename, click OK to continue. 

Creating a SQL Server Database 

1. Select SQL Server Database at the top of the dialog. 

 
2. Select the name of the SQL server from the drop down list provided. 

Normally every SQL Server on the network will be displayed in the drop 
down list, but the name (or IP address) may need to be entered. 

3. Create a new database by entering a Database Name in the text box 
provided or connect to an existing database by selecting the Database 
Name from the drop-down list.  
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4. Use the radio buttons to select the authentication type for the SQL Server 
and then click OK to continue. 

¤  If the SQL Server ID and password option is used, an ID with sufficient rights to create 
new databases on that server must be used (for example, the SQL Administrator 
account). 

 

5. Select a location to save the database by navigating to the desired path 
and then click OK to continue. 

Setting the System Defaults 

After creating a database, the System Default settings will need to be set.  These 
are fields such as Default Community String, Default Username, and Default 
Execute Protocol.  When adding Nodes, the System Default settings are used 
unless otherwise specified. 
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1. Click Next à  to begin the System Defaults setup. 

 

2. Enter the default community string for the Nodes on the network, and 
click Next à  to continue. 

 

3. Enter the Default Username, Password, Enable Level, and Enable 
Password.  Click Next à  to proceed. 
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4. Enter the Default Execute Protocol and Download/Upload Protocol, 
and then click Next à  to continue. 

 

5. Select a field to group the Nodes by in t he Node List from the 
dropdown menu.  If no grouping is required, select “<none>” at the top 
of the list. 

 

6. Enter the default Windows User information for Scheduled Job 
Authentication.  This is the username and password of the Windows 
account the Scheduled Jobs will run as.  Click the Finished button to 
complete the Startup Wizard. 

What to Do Next 
After successfully completing the Startup Wizard, the database must be populated 
with the network Nodes that are to be managed. This can be accomplished by 
either adding Nodes individually or by importing a list of Nodes. 

Instructions on adding Nodes individually are located in Chapter 3: Managing 
Nodes on page 19. 

Details on importing a list of Nodes can be found in Chapter 3: Managing Nodes on 
page 21.





 

   

Chapter 3: Managing Nodes 
After creating a database, Nodes will need to be added to the Cirrus database.  
There are two ways to add a Node; add one device at a time, or importing a list of 
Nodes from a file.  These two processes are described in this chapter. 

Adding Nodes 

To add a single Node, click the  button on the toolbar, or select Add New Node 
from the Nodes menu.  Once the Add New Device dialog is displayed, enter the 
Node’s hostname or IP Address, login information, and communication protocols.  
In some cases, the Device Command Template will not be discovered automatically.  
If this happens, set the template manually by using the dropdown menu to assign 
a specific Device Command Template. 

¤  The default Device Command Template (Auto Detect) should always be tried first.  If Cirrus is 
unable to determine the appropriate Device Command Template, or assigns the wrong template, 
then set it manually. 

Also be sure to enter an appropriate Node Group for the Node.  The Node Group is 
used by default to organize the Node Tree that is listed on the right side of the 
application.  If the Node that is being added uses HTTPS when connecting to its 
web interface, set Browse via HTTPS to Yes. 

 

¤  To find Node information, use the Telnet or Web Browse buttons to connect to the device. 
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When entering the Login Information, enter the values just as they would be typed 
when manually logging into the device.  For example, if the only thing that needs 
to be typed for Enable Level 15 is “15”, then simply enter “15” for the value. 

Four options are available for Command Execute Protocol and Config Transfer 
Protocol; TELNET, SSH1, SSH2, and SSH Auto.  When selecting SSH Auto, Cirrus 
will first attempt to negotiate an SSH2 connection, if SSH2 is not supported, it will 
default to SSH1. 

To confirm the community string is valid, click the Verify SNMP Community button. 

 

To ensure the login information is accurate, click the Verify Login Information 
button. 
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Click the OK button to add the Node to the database.  Clicking OK will 
automatically verify the community string and login information before adding 
the device. 

¤  To keep the window open and add additional Nodes, ensure the Keep this window open so I 
can add more Nodes checkbox is selected. 

Importing a List of Nodes 
As opposed to entering Nodes one at a time, a list of Nodes can be imported from 
several different file types.  Nodes can be imported from text files, Excel 
spreadsheets, Access databases, SQL databases, and Orion NPM or Engineer’s 
Edition NPM databases.  Cirrus can even import Nodes from a CiscoWorks or 
Kiwi CatTools database export. 

Although there are small differences in the import process depending on the type 
of file used, most of the options are the same.  The file-specific options are listed at 
the end of this section. 

To launch the Import Wizard, select Import Devices from the File Menu. 

 

Select the file type from the list and then click Next à .  Select the file to import by 
either typing in the path, or by browsing to it, and then click Next à .  
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Assign each column a field name by clicking on the column header and selecting a 
field from the drop down list.  To bypass a column during the import process, 
select “<ignore>” from the list.  Once satisfied with the column name assignments, 
click Next à . 

 

By default, all Nodes in the list will be included in the import.  If there are Nodes 
in the list that need to be excluded, uncheck them, and then click Next à  to 
continue. 

The last page has two options; one allows the user to exclude Nodes that already 
exist in the Cirrus database, the other will discover details about the Nodes being 
imported.  Leave the box checked to exclude Nodes with IP Addresses that 
already exist in the database.  If importing a large list of Nodes, to save time, 
uncheck the option to discover device details after the import.  Click Import to 
begin the import process.  Once the process has complete, click Done to close the 
dialog. 

Importing a Text File - Selecting Column Delimiters 

When importing from a text file, Column Delimiters will need to be defined. 
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Select the column delimiter used in the text file to separate each field.  This is 
normally a comma or a space, or a combination of characters.  As changes are 
made, the columns will align differently based on the selection(s).  Once the 
columns are separated properly, click Next à . 

Importing an Excel Spreadsheet – Selecting the Worksheet 

When importing from an Excel spreadsheet, the worksheet will need to be 
selected. 

 

Select the worksheet from the drop-down list at the top of the dialog and then 
click Next à  to continue the import process. 

Importing from a SQL database – Connecting to the Server 

When importing from an Orion NPM database or any other SQL database, a 
connection to the server will first need to be established. 
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Select the SQL server from the drop-down list or type the server’s IP Address or 
hostname.  Then select the database name from the second drop-down list and 
choose the type of authentication required for the connection.  Click Next à  to 
continue the import process. 
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Editing Nodes 
Once a Node has been added, the device’s details can be modified by right-
clicking on the Node in the Node List and then selecting Edit Selected Nodes. 

Device Details Tab 

The Device Details tab is used to change the Node Name, Node Group, IP 
Address, login information, and more.  Fields that appear in gray boxes can be 
edited.  Double-click the field to edit the existing value, or use the drop-down list 
to select a different value. 

 

Interfaces Tab 

This tab is used to display interface details of a specific Node.  Choose a category 
from the Interface Details drop-down menu and then click the Refresh button to 
display the selected statistics. 
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Check the Auto Refresh box to automatically update the statistics every 30 seconds. 

¤  To change the Auto Refresh time interval, select Settings from the File menu and then select 
Interfaces under the Node Details Window section.  Adjust the slider to the desired interval and 
click OK to save the changes. 

Right-click on an interface to see additional options such as Bandwidth Gauges, 
Graph Selected Statistics, Shutdown Selected Interface, and more. 

Configuration History Tab 

The Configuration History tab lists all configs that have been downloaded for the 
selected Node.  The configs are separated by time periods such as “Last Week”, 
“Two Weeks Ago”, “Last Month”, and so on. 

Right-click on a config or group of configs to be presented with additional options 
such as Edit Configs, Compare Selected Configs, Upload Selected Configs, and 
more. 
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Inventory Tab 

The Inventory tab displays the information collected by the Inventory Engine.  A 
dropdown menu is listed at the top categorizing the different statistics that can be 
displayed.  Click a category to display the associated statistics.  If no statistics are 
available, it may be necessary to perform an inventory on the selected node. 

¤  For detailed instructions on performing Inventory, please refer to Chapter 6: Inventory on page 
65. 

 



Cirrus Configuration Management    

 Editing Multiple Nodes 28

Editing Multiple Nodes 
Many times it is necessary to make changes to more than one Node at a time.  To 
edit two or more Nodes at the same time, select the devices on the Node List by 
using the Shift and Ctrl keys on the keyboard, and then right-click and select Edit 
Multiple Nodes. 

The Edit Multiple Devices dialog is displayed listing the Nodes that have been 
selected at the top.  To add or remove Nodes from the list, use the associated 
buttons below the list. 

 

Make the appropriate changes to the Nodes and click Done to accept the changes.  
It may be necessary to refresh the Node List to show the changes by pressing the 

 button at the top of the Node List. 

Custom Properties 
Cirrus includes the ability to add Custom Properties to each Node.  Custom 
Properties are additional fields such as country, building, asset tag, serial number, 
etc. that can be defined and stored in the Cirrus database. 

Cirrus provides a collection of the most commonly utilized properties to choose 
from.  New custom properties can also be defined.  Once a custom property is 
created, the properties can be edited in the Node Details of each device. 

To define a Custom Property, click the  button on the toolbar, or select 
Settings from the File menu, and then select Custom Properties from the menu on 
the left.  Select a property from the drop-down list or type in a new property, and 
then click the Add New Property button to create the Custom Property. 
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Once a Custom Property exists, the field will be displayed when viewing Node 
Details.  To edit the Custom Properties, right-click on a node or group of nodes 
and click Edit Selected Nodes or Edit Multiple Nodes.  The new Custom Properties 
will be displayed at the bottom of the Node Details. 

 

Enter the new values for the Custom Properties and then click Done to save the 
changes. 





 

   

Chapter 4: Managing Configs 
After adding Nodes, it’s time to start managing configuration files.  Configs can be 
downloaded, edited, compared, and uploaded all from the same console.  This 
chapter explains the various tasks that help ease the pain of managing Configs. 

Downloading Configs 
To download a config from a single node, or group of nodes, right-click on a node, 
group, or selection of nodes and select Download Configs. 

 

Nodes can be added or removed from the list of Nodes by using the associated 
buttons below the list of Nodes. 

Select the type of config to download, either Running or Startup, and then check 
any After Download options needed such as View / Edit Downloaded Config.  Click 
Download to start the transfer. 

 

Once the download has finished, the configs are written to the database and any 
After Download options will be performed. 



Cirrus Configuration Management    

 Editing Configs 32

Editing Configs 
To edit an existing configuration file, right-click on the file from the Node List and 
a select Edit Selected Configs, or simply double-click the file. 

 

Saving Changes with Revisions 

After making any changes to the configuration file, clicking the Save Changes 
button will open the Revision Comments dialog.  This is used to enter any details 
regarding the changes made to the configuration file. 

 

Enter a description of the changes made and click OK to save the configuration file.  
The revision is saved below the existing configuration file as a separate file with 
the Revision Comments as the name. 
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Decrypting Cisco Type 7 Passwords 

When viewing a configuration file, encrypted Cisco Type 7 passwords can be 
decrypted with the touch of a button.  With a configuration file open, click the 
Actions button and then select Decrypt Type 7 Passwords. 

 

Cirrus will scan the entire configuration file for all Cisco Type 7 encrypted 
passwords.  All passwords that have been decrypted will appear green. 

+  Decrypting the Type 7 Passwords alters the text of the configuration file.  If the configuration 
file is saved after decrypting the passwords, the passwords will be saved without encryption. 
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Comparing Configs 
Another feature of Cirrus is the ability to compare configuration files.  Configs can 
be compared between two Nodes, or compare an older version with the current 
configuration. 

To compare two configuration files, select the two files that are to be compared 
from the Node List and then right-click and select Compare Selected Configs. 
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The compared files will be shown in a side by side view.  Lines that have been 
changed will be highlighted in yellow.  Missing lines are highlighted in red.  A 
green highlight means that the line has been added. 

A Comparison Overview is displayed to the left of the side by side comparison.  
This scales to fit the size of the window allowing for an overview of the entire 
comparison.  Click anywhere on the Comparison Overview to jump to the 
associated section of the configs being compared. 

Also, the comparison can easily be printed by selecting Print from the File menu. 

Setting a Baseline Config 
A Baseline Config is a configuration file that is known to be a good configuration.  
When making a number of changes to a Node’s configuration, it’s a good idea to 
establish a known good configuration as a Baseline for future comparisons. 

To set an existing configuration file as a Baseline, right-click on the config in the 
Node List and select Set/Clear Baseline Setting. 

 

The config will then be highlighted in bold, and the word “Baseline” will be added 
to the beginning of the name of the config. 
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¤  Several baseline configs can be established.  To assign additional Baselines, right-click on a 
Node or group of Nodes and click Set/Clear Baseline Setting. 

When downloading new configurations with a Baseline Config established for the 
same Node, check the option Compare to last Baseline Config in the Download 
Config dialog to automatically compare the new config to the Baseline. 

 

To remove the Baseline flag from a configuration file, right-click on the config in 
the Node List and select Set/Clear Baseline Setting. 

Baseline Entire Network 

In some situations, it may be appropriate to establish a Baseline configuration for 
every Node on the Network.  The Baseline can be set to the last config 
downloaded for each Node, or it can be set to the configs downloaded on a 
specific date. 

To create a Baseline for all Nodes, click the  button on the toolbar, or select 
Baseline Entire Network from the Configs menu.  Select either the option to 
designate the last downloaded config of each node as a Baseline, or set the 
Baseline based on configs that were downloaded on a specific date.  Click the Set 
Baseline button to flag the specified configs as Baseline Configs. 
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Config Change Reports 
A Config Change Report shows all changes made between each configuration file 
over a specific time period.  These Reports can show all changes that occurred 
during a specific date range, or all differences between the latest downloaded 
config and the Baseline Config. 

To view this Report, select Config Change Report from the Configs menu. 

 

At the bottom of the dialog, select the type of Config Change Report to generate.  
The default selection (Compare most recent Download the last Baseline Config) will 
display all the differences between the last Baseline Config, and the most recent 
Downloaded Config. 

The second option, Compare the most recent Download to the Configuration on a 
specific Date, will show all differences between the most recent Downloaded 
Config and a Configuration on the specified date. 

¤  If there was no Config downloaded on the specified date, the next Config after that date will 
be used for the comparison. 

The last two options will show all changes made to a Node configuration that 
have occurred during a specific date range. 
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Select the type of Config Change Report to create, and then click the Generate 
Report button.  The Report will be displayed on the Results tab. 

 

Comparison Criteria and RegEx Patterns 

When viewing Config Change Reports, some changes can be ignored such as the 
'!Last Configuration change' line in Cisco configs.  To determine which lines 
should be ignored, click the Comparison Criteria button. 

 

RegEx Patterns are used by Cirrus Configuration Management to ignore 
differences in certain lines when comparing configuration files.  RegEx Patterns 
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describe the lines that are to be ignored.  RegEx Patterns are global, and when a 
RegEx Pattern is enabled, it is used for all comparison operations throughout 
Cirrus Configuration Management, including Scheduled Jobs. 

Each line that matches a given RegEx Pattern will be ignored when comparing 
files, however, when a changed line that is being ignored by a RegEx is above or 
below another line which is not ignored due to a RegEx Pattern, both lines are 
shown.  Both lines must match one or more RegEx Patterns for the lines to be 
ignored. 

There are a few example comparisons included with Cirrus.  To enable a 
Comparison Criteria, check the box next to the pattern that is to be ignored.  To 
create a new pattern, click the Add Pattern button. 

 

Give the Comparison Criteria a name and add a comment if necessary.  In the 
RegEx Pattern field, enter the RegEx Pattern that Cirrus is to ignore when running 
the Config Change Report. 

When the Config Change Report is executed, any lines that match one of the 
Comparison Criteria will be excluded in the Report. 

¤  For more information about RegEx Patterns, refer to Appendix D: Regular Expression Pattern 
Matching on page 147. 
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Advanced Options 

Before generating a Report, click the  button to display the Advanced Options. 

 

Check Show detailed changes to display the differences between each 
configuration file separately.  This will show each change from one config to the 
next.  For example, if there were 4 configuration changes made in a specific date 
range, the Report will show the differences in the first config compared to the 
second config, and then show the differences in the second config compared to the 
third, and so on.  The Report will be grouped by date, showing all changes made 
on each day. 
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Config Snippets 
A Config Snippets is a string of text that can be saved to a file allowing the user to 
merge sections of configs with ease.  Config Snippets can be used to edit an 
existing config, or can even be uploaded directly to a Node or group of Nodes. 

Creating a New Config Snippet 

To create a new Config Snippet from scratch, click the New Snippet button at the 
top of the Config Snippets panel on the right-hand side. 
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¤  If the Config Snippets panel is not displayed, it can be opened by selecting Config Snippets 
from the Windows menu. 

Enter text for the new Config Snippet in the large text box provided.  Give the 
Snippet a name (“New Snippet” by default) and click the Save Changes button. 

Config Snippets can also be created by right-clicking on a selection of text and 
selecting Create Snippet from Selection. 

 



C  Recycled Paper Chapter 4: Managing Configs   

Uploading Configs   43

Uploading Configs 
After editing configurations files, they can be uploaded to a node or group of 
nodes with ease.  There are three different ways to upload configuration changes; 
Uploading and Entire Config, Uploading Selected Lines, and Uploading a Config 
Snippet. 

Uploading an Entire Config 

To upload an entire configuration file, right-click on the file and select Upload 
Config.  Configuration files can also be uploaded when editing the config by 
clicking on Action à  Upload Entire Config. 

 

The Upload Config dialog is displayed.  Additional Nodes can be added to the list 
of Nodes to upload to by using the associated buttons below the list. 
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If the configuration needs to be written to NVRAM or if the device needs to be 
rebooted following the upload, check the appropriate options at the bottom, and 
then click Create Upload Script to open the Execute Script dialog. 

 

In the Execute Script dialog, Nodes can be added or removed, and the command 
script can be saved.  Also, previous command scripts can be loaded to replace the 
automatically generated script.  Once satisfied with the command script, click the 
Execute Command Script button to begin the upload process. 
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As the script is executed, the Results tab displays the progress as the configuration 
changes are uploaded.  Once the upload command script completes, the results 
can be save by clicking the Save Results button at the top of the dialog. 

Uploading Selected Lines 

There are times when it is only necessary to upload a few lines of a configuration 
file.  Cirrus includes the ability to upload only specific lines of a config.  When 
editing a configuration file or Config Snippet, highlight the line(s) need to be 
uploaded, right-click, and select Upload Selected Lines. 

 

The Upload Config dialog is displayed.  Additional Nodes can be added to the list 
of Nodes to upload to by using the associated buttons below the list. 
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If the configuration needs to be written to NVRAM or if the device needs to be 
rebooted following the upload, check the appropriate options at the bottom, and 
then click Create Upload Script open the Execute Script dialog. 

 

In the Execute Script dialog, Nodes can be added or removed, and the command 
script can be saved.  Also, previous command scripts can be loaded to replace the 
automatically generated script.  Once satisfied with the command script, click the 
Execute Command Script button to begin the upload process. 
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As the script is executed, the Results tab displays the progress as the configuration 
changes are uploaded.  Once the upload command script completes, the results 
can be save by clicking the Save Results button at the top of the dialog. 

Uploading a Config Snippet 

To upload a Config Snippet, either right-click on the Snippet in the Config 
Snippets window and click Upload to Devices, or click Actions à  Upload Entire 
Config when editing the Snippet. 

 

The Upload Config dialog is displayed.  Additional Nodes can be added to the list 
of Nodes to upload to by using the associated buttons below the list. 

 

If the configuration needs to be written to NVRAM or if the device needs to be 
rebooted following the upload, check the appropriate options at the bottom, and 
then click Create Upload Script open the Execute Script dialog. 
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In the Execute Script dialog, Nodes can be added or removed, and the command 
script can be saved.  Also, previous command scripts can be loaded to replace the 
automatically generated script.  Once satisfied with the upload command script, 
click the Execute Command Script button to begin the upload process. 

 

As the script is executed, the Results tab displays the progress as the configuration 
changes are uploaded.  Once the upload command script completes, the results 
can be save by clicking the Save Results button at the top of the dialog. 
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Finding an Address 
Cirrus includes a search engine that will search the entire database (Nodes, 
configuration files, and Inventory) for a specific address.  To open the Find 
Address tool, click the Find Address tab on the right side of the screen. 

¤  If Find Address is not displayed here, select Find Address from the Windows menu. 

Select MAC Address, IP Address, or Hostname, enter the Address Pattern, and 
then click the Find button. 

 

Once the results are displayed, right-click on a result and select View Selected Node 
to see the Node Details of the associated device. 

To ensure the most accurate and complete results are available, click the Update 
Inventory button listed at the bottom of this tab to rescan all Nodes in the database 
for any updated information. 
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Search Configs 
To search for specific strings of text within the configuration files stored in the 
Cirrus database, click the  button on the toolbar or select Search Configs from 
the Edit menu. 

 

Click the Add Devices button to select which nodes to search.  Alternately, click the 
Select Nodes Directly dropdown list and select either All Nodes or Specify a 
Selection Criteria. 

Once the devices or selection criteria have been selected, enter a string of text and 
click Start Search to search through the last downloaded config of each Node 
selected. 

To search through more than just the last downloaded configuration files, click the 
 button to expand the Search Criteria. 
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With the Search Criteria expanded, specify this week, this month, last month, or a 
specific date range.  The type of configs to search can also be selected in this 
expanded window.  Click Start Search to scan the database for the specified text 
within the date range selected. 

Once the search completes, the Results tab is displayed.  The results can be saved 
by clicking the Save Results button at the top of the dialog. 
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Purging Configs from the Database 
As the Cirrus database grows in size, it may be necessary to delete existing 
configuration files from the database.  To purge the database, select Purge Configs 
from the Configs menu. 

 

On the Select Devices tab, choose the nodes that need to have configuration files 
removed.  There are three ways to select Nodes; All Nodes in the Database, Select 
Nodes Directly, and Specify a Selection Criteria.  To change the selection method, 
click the Select Nodes Directly button and choose the new method. 

 

¤  For details on how to specify selection criteria, please refer to page 54. 

Selecting the Purge Method 

With the Nodes selected, click the Select Purge Method tab to establish which 
configs will be removed. 
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To remove configs older than a specific date, select Purge all Configs downloaded 
before: and then, specify the date and time (if required) by using the drop-down 
menus or by typing the date/time in the appropriate boxes. 

 

Alternately, to remove all configs and keep only the last few, select Purge all 
Configs except the last 10, and then move the slider to adjust how many 
configuration files should be kept in the database. 
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Once the Purge Method has been established, click the Purge button to remove the 
configuration files from the database. 

 

Once the Purge has completed, click Purge More Configs to setup another purge, or 
click Done to close the window. 

Specifying a Selection Criteria 

In some instances, it may be easier to specify selection criteria as opposed to 
selecting a group of nodes.  On the Select Devices tab, click the Select Nodes Directly 
button and select Specify a Selection Criteria. 

 

Two types of filtering conditions are available, each of which may be chosen from 
a list accessed by clicking the Ellipsis button at the left of each filter’s entry. 
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Choose the type of condition needed, referring to the following Condition Table 
for guidance in selecting the appropriate condition type. 

 

Add an Elementary Condition using the Ellipsis button.  Click the first asterisk (*) 
and select the desired field using the flyout menu. 

 

After selecting a field, choose a comparison, such as “is equal to”, and then enter 
the value or select it from the dropdown list. 

Condition Options 

Elementary 

Records where * (=DatabaseField)   *(= SpecifiedValue) 

Complex 

Select records where  of the following apply 
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¤  When clicking the dropdown menu for the value, all values currently in the database for that 
field are displayed. 

Once finished creating the selection criteria, choose a purge method and then click 
Purge to remove the configuration files from the database. 

¤  For details on selecting a purge method, please refer to page 52



 

   

Chapter 5: Command Scripts 
Command Scripts can be executed to accomplish several different types of tasks 
such as Downloading Configs, Uploading Configs, Uploading IOS Images, 
Updating Login Banners, Access Control Lists (ACLs), and more.  With the use of 
macros, a single script can be executed on several different device types without 
having to worry about syntax differences between each device. 

Getting Started 

To launch the Execute Command Script window, click the  button on the 
toolbar, or select Execute Command Script from the Nodes menu. 

 

Selecting Nodes 
Once the Execute Command Script window is displayed, devices can be added 
using the associated buttons below the list of Nodes.  To select a group of Nodes, 
choose the option Select Nodes Directly or Specify a Selection Criteria.  Otherwise, 
select All Nodes in the Database to execute the script on every Node. 
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With the option Select Nodes Directly selected, click the  button 
and choose the Nodes and/or Groups that are to be applied to this script and then 
click the OK button. 

 

To select a group of Nodes based on a specific set of conditions, select the option 
Specify a Selection Criteria.  Add a condition by clicking the  button and then 
click Add a Simple Condition. 
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Click the first asterisk (*) and then select the desired field using the submenu. 

 

Select a condition (the default condition is “is equal to”) and then click the second 
asterisk (*) to assign a value for the condition.  Type a value, or select one from the 
drop-down list. 
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¤  When clicking the dropdown menu for the value, all values currently in the database for that 
field are displayed. 

Click the OK button once satisfied with the selection criteria, or group of Nodes. 

Executing Command Scripts 
Once satisfied with the selection of Nodes, type the script that is to be executed.  
The script consists of a single command or list of commands to be sequentially 
executed.  The script should mirror commands entered when manually entering 
instructions using the command prompt.  For example, when sending the “show 
version” command to a router via a TELNET session, the prompt requires the user 
to enter “sh version”.  Add one line to the script that has the exact phrase as it is 
typed in the command prompt “sh version” (without quotes) with a carriage 
return (ENTER key) at the end of the line. 

Click the Execute Command Script button to start the script.  The Results tab will be 
opened automatically and the outcome of the script will be displayed as the 
output is received. 

 

'  Uncheck the Outline View check box to display the results without any formatting. 
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Saving and Loading Command Scripts 

After running a successful script, the script can be saved for later use.  On the 
Execute Script tab, click the Save Script button, type a filename and then click the 
Save button. 

To load a previously saved script, or one of the example scripts that ships with 
Cirrus, click the Load Script button.  To view the prepackaged example scripts, 
open the \Sample Scripts folder and select one of the available scripts. 

 

Advanced Options 

To display the Advanced Options, click the  button at the bottom-right of the 
window.  The additional options are displayed below the Command Script to 
Execute text box. 
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The Filter results that match a Pattern option allows the user to show only the 
results that meet specific criteria when the script is executed.  For example, adding 
the word “Serial” to the filter will only display lines that start with the word 
“Serial”.  This specific filter is useful in trying to find the Serial Number of a Node 
or group of Nodes.  The example script Get Serial Number from each Device.txt 
demonstrates this feature. 

¤  For details on Pattern Matching for filters, see Appendix D: Regular Expression Pattern Matching 
on page 147. 

To automatically write the results of the script to a file, check the Save Results to a 
File check box.  Type the path and filename for the log file, or click the  button to 
browse to a path and select a filename. 

To hide the commands that are sent when the script is executed, uncheck the Show 
Commands in Output check box. 

Using Macros within Scripts 
One of the features that makes the Cirrus Scripting Engine so powerful is the 
ability to use macros within scripts.  Cirrus Configuration Management uses a 
similar macro system as the one in Orion Network Performance Monitor.  Macros 
always begin with a dollar sign and curly brace ${  and always end with a curly 
brace  }. 
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These script macros are used to substitute the appropriate commands based on the 
device type.  For example, the macro ${EnterConfigMode} will parse as "config 
terminal" when communicating with Cisco IOS devices, but will parse as 
"configure" when communicating with an HP Procurve Switch. 

Example Macro Script 

Script containing macros that 
removes the “public” Read-Only 
Community String 

${EnterConfigMode} 
no snmp-server community public RO 
${ExitConfigMode} 
${SaveConfig} 
${Reboot} 

The same Script as it parses for 
Cisco IOS devices 

config terminal 
no snmp-server community public RO 
end 
write memory 
reload${CRLF}y${CRLF}y 

The same Script as it parses for 
a Dell PowerConnect Switch 

config 
no snmp-server community public RO 
end 
copy running-config startup-config${CRLF}${CRLF} 
reload${CRLF}Yes 

Note: the ${CRLF} macro parses as a Carriage Return Line Feed. 

 

Script Macros are defined in Device Command Templates.  These templates reside 
in the C:\Program Files\SolarWinds\Configuration Management\DeviceTypes 
folder.  Each .ConfigMgmt-Commands file contains a System OID that is used to 
uniquely identify a device.  Also included is a list of Command Names and the 
commands that will be sent to the device when the Command Name is called.  
These Command Names are the macros that are used when creating a script. 

Here is a line taken from the Cisco IOS Device Command Template: 

<Command Name="EnterConfigMode" Value="config terminal"/> 

In this example, when a script is run on a Cisco IOS device, the macro 
${EnterConfigMode} will parse as “config terminal”.  New Command Names can 
be added as well as existing Command Names can me modified within these files. 

+  Changing Device Command Templates alters the way Cirrus communicates with network 
devices.  SolarWinds does not recommend changing a Device Command Template unless the 
user has advanced knowledge and experience with device commands and use of macros. 

For a list of macros that can be used in Command Scripts and Device Command 
Templates, refer to Appendix C: Macros on page 146. 





 

   

Chapter 6: Inventory 
In addition to all of the config management functions, Cirrus has a very robust 
Inventory Engine.  Inventory can be performed on all nodes, a group of Nodes, or 
just one Node at a time.  The statistics collected by the Inventory Engine can easily 
be viewed in each device’s details view. 

Performing a Full Inventory 
To perform an inventory on all Nodes managed by Cirrus, select Start Full 
Inventory from the Inventory menu. 

 

¤  A Full Inventory can take several minutes, or even hours to complete depending on how 
many Nodes are being managed, and what Inventory statistics are being polled. 

To establish what statistics will be collected, please refer to Inventory Settings on 
page 66. 

Running Inventory on a Single Device or Group 
When needing to perform inventory on a single Node or group of Nodes, right-
click on a node, node group, or selection of nodes and select Inventory Selected 
Nodes. 
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Scheduling an Inventory 
A full Inventory can be scheduled to run on a regular basis.  To create a new 
Inventory Job, select Schedule Inventory from the Inventory menu.  Give the Job a 
name, and then establish the time interval for the Job. 

 

For more detailed instructions on Scheduling Tasks, please refer to Chapter 8: 
Scheduling Tasks on page 75. 

Inventory Settings 
Different networks require different statistics to be recorded during an inventory.  
To specify which statistics are collected during an inventory, open the Inventory 
Settings window by selecting Inventory Settings from the Inventory menu. 
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Check the statistics that are required for inventory and click OK to save the 
changes.  The next time an inventory is performed, only the selected statistics will 
be collected. 

Viewing Inventory 
To view the inventory statistics collected by Cirrus, right-click on a Node, select 
Edit Selected Nodes, and then click the Inventory tab. 

The Inventory tab displays the information collected by the Inventory Engine.  A 
sub menu is listed on the left side categorizing the different statistics that can be 
displayed.  Click a category on the right to display the associated statistics.  If no 
statistics are available, it may be necessary to perform an inventory on the selected 
node. 
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These statistics can also be viewed directly from the database.  To do this, open the 
Cirrus database using Microsoft Access or SQL Enterprise Manager.  Each group 
of statistics will be stored in a corresponding table.  Reports and queries can be 
performed just like any other database.  For details on how to create reports or 
queries, refer to the documentation provided with Microsoft Access or SQL 
Enterprise Manager.



 

   

Chapter 7: Reports 
SolarWinds has developed a Report viewer application, which provides a quick 
and easy way of extracting data from the database and displaying it in an easy to 
read format. 

Several standard reports are included in the distribution of the program, which 
can be modified, and new reports can be created as necessary.  Reports can be 
printed or emailed with just a click of a button. 

Viewing Reports 
To view a Report, select View Report from the Reports menu, select a Report and 
then click OK, or simply double-click the Report. 

 

The report is displayed in a new tab with Report specific buttons added at the top 
of the tab.  To print the Report, select Print from the File menu.  To email the 
Report, select Send To à  Mail Recipient from the File menu. 
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Creating and Editing Reports 
To create a new Report, select New Report from the Reports menu.  The Customize 
Report dialog is displayed. 

Alternately, to edit an existing Report, select View Report from the Reports menu, 
and then open the Report that is to be modified.  Click the Modify Report button to 
display the Customize Report dialog. 

General Tab 

The General tab is used to establish basic Report settings such as the Report Title, 
the Print Orientation, and the Filename. 

 

Click the Ellipsis button to the right of the Filename field to choose a path and 
filename for the Report. 

¤  The default location for Reports is C:\Program Files\SolarWinds\Configuration 
Management\Reports.  In order for a Report to be included with the list of existing Reports, it 
must be saved in the Reports folder under the Configuration Management folder. 

Give the new Report a title, and then create a Sub Title and Description (these are 
optional fields).  Set the Print Orientation (Portrait or Landscape), and select 
Display current device Up/Down Status and/or Group/Merge similar rows if desired.  
Also set what type of line will be displayed (No Lines, Grid Lines, or Horizontal 
Lines). 
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Select Fields Tab 

 
On the Select Fields tab, select the properties that are to be added to the Report and 
click the  button to add the field. 

 

To group the nodes by a category, click the dropdown list at the top and select the 
desired category.  Custom Properties can be used when grouping Nodes. 

¤  For information on how to create Custom Properties, please refer to the Custom Properties 
section in Chapter 3: Managing Nodes on page 28. 
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Filter Results Tab 

The results of a Report can be filtered to display only the necessary information.  
Two types of filtering conditions are available, each of which may be chosen from 
a list accessed by clicking the Ellipsis button at the left of each filter’s entry. 

Choose the type of condition needed, referring to the following Condition Table 
for guidance in selecting the appropriate condition type. 

Add an Elementary Condition using the Ellipsis button.  Click the first asterisk (*) 
and select the desired field using the flyout menu. 

 

After selecting a field, choose a comparison, such as “is equal to”, and then enter 
the value or select it from the dropdown list. 

Condition Options 

Elementary 

Records where * (=DatabaseField)   *(= SpecifiedValue) 

Complex 

Select records where  of the following apply 
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¤  When clicking the dropdown menu for the value, all values currently in the database for that 
field are displayed. 

At the bottom of this tab is a section called Top xx records only.  This section is used 
to limit the amount of records displayed when the report is executed.  All Records 
is selected by default.  Select Show only the Top XX Records to specify a number of 
reports to display.  Alternately, select Show the Top XX % of Records to display 
only a specific percentage of results. 

Click OK once finished creating any filters and establishing the amount of records 
to display. 

To save the changes to the Report, click the Save Changes button displayed above 
the Report. 

Deleting Reports 

To delete an existing Report, select View Report from the Reports menu, select a 
Report or group of Reports, and then click the Delete Selected Reports button. 

Scheduling Reports 
To schedule a Report to be emailed or printed, select Schedule Report from the 
Reports menu. The Schedule Report dialog is displayed prompting for a name for 
the task.  Give the task a name and then finish the Schedule Task Wizard.  For 
detailed instructions on how to configure scheduled tasks, please refer to Chapter 
8: Scheduling Tasks on page 75.





 

   

Chapter 8: Scheduling Tasks 
With Cirrus’s scheduled task feature, managing routers has never been easier.  
Some of these tasks include config uploads, config downloads, Node reboots, 
executing command scripts, and more. 

Cirrus uses the Windows Task Scheduler to organize the scheduled operations.  
Any Job created with Cirrus can be viewed and modified with the Windows Task 
Scheduler.  This can be opened by clicking on the Windows Start button and going 
to Start à  Programs à  Accessories à  System Tools à  Scheduled Tasks. 

Creating a New Job 
To start creating a new Job, select Create New Job from the Schedule menu.  Type a 
name for the Job and then click Next à . 

 

Select the type of Job to be scheduled and then click Next à . 

 

Set the Schedule Type, Start Time, Starting Date, and Ending Date.  Depending on 
the schedule type (Daily, Weekly, Monthly, etc.), the area at the bottom of the 
dialog will display additional options. 
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¤  To assign a Job to run with no End Date, leave the Ending On field blank. 

Set the Windows User Information by assigning the Job a Windows user account 
and password to run as, and then click Finish. 

 

After clicking Finish, the Edit Job dialog is displayed.  Follow the steps listed in the 
following section, Editing and Copying Jobs, to finish configuring the Job. 

Editing a Job 
After creating a Job schedule, the Job details need to be configured.  If the Edit Job 
dialog is not already displayed, right-click on a Job and select Edit Job. 

¤  To display the list of Jobs, click the  button on the toolbar, or select Display/Edit Jobs from 
the Schedule menu. 

On the General tab, the Job can be Enabled/Disabled, the schedule can be modified, 
and comments can be added. 
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¤  The second tab, “Nodes” in this example, will be different based on the type of Job created.  
For details on the different settings displayed in this tab, please refer to the Job Specific 
Settings section on page 78. 

When a Job completes, a notification can be sent along with the completion status 
details.  Use the Notifications tab to setup printer or Email notifications.  Recording 
the Job status details can also be enabled here. 

 

Click Test Notifications to ensure all Notification settings are configured properly. 

On the Security tab, set the Windows User Information by assigning the Job a 
Windows user account and password to run as, and then click the Set Username 
and Password button. 
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Job Specific Settings 
Different settings will be displayed on additional tabs in the Edit Job dialog 
depending on the type of Job that is being configured. 

Nodes Tab 

When editing a Job that with one of the following types, the Nodes tab will be 
displayed: 

• Execute Command Script on Devices 

• Download Configs from Devices 

• Upload Changes to Devices 

• Reboot Selected Devices 

• Config Change Report 

By default, the Job is assigned to All Nodes.  To select a group of Nodes, choose the 
option Select Nodes for this Job Directly or Specify a Selection Criteria. 

With the option Select Nodes for this Job Directly selected, click the 

 button and choose the Nodes and/or Groups that are to be 
applied to this Job and then click OK. 
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If, instead, the option Specify a Selection Criteria is selected, click the  button and 
select Add a Simple Condition. 

 

Click the first asterisk (*) and select the desired field using the fly-out menu. 
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Select the condition (the default is “is equal to”) and then click the second asterisk 
(*) to assign a value for the condition. 

 

¤  When clicking the dropdown menu for the value, all values currently in the database for that 
field are displayed. 

Download Config Tab 

This tab is used to select which types of configs to download, and what actions are 
to be perform upon the completion of the downloads. 
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A notification E-mail can be sent when a downloaded config is different than the 
last config or different than the Baseline config.  Check Only save Configs that have 
changed to discard any configs that have no changes. 

Click the Edit Comparison Criteria to configure Cirrus to ignore specific lines of a 
configuration file.  For more information on Comparison Criteria, see Comparison 
Criteria and RegEx Patterns in Chapter 4: Managing Configs on page 38. 

Command Script Tab 

When editing a Job that executes a command script, the Command Script tab will 
be displayed. 

 

Type the command script that is to be executed in the text box provided.  The 
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script can also be loaded from a file by clicking the  button, selecting 
a file, and then clicking OK. 

Report Tab 

When editing a Job that runs a Report, the Report tab will be displayed. 

 

On the Report tab, just select the Report that is to be executed.  Only one Report 
can be executed at a time.  To execute more Reports, a new Job will have to be 
created for each additional Report. 

Config Mirror Tab 

When editing a Job that exports configs, the Config Mirror Location tab will be 
displayed. 
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Select the path to export the configs to, and set the template for the filename 
structure.  Select which configs (Running and/or Startup) to export, and choose 
whether to export all configs, or just the last downloaded for each node, and then 
click OK to save any changes. 

Program Tab 

When editing a Job that executes a program, the Program tab will be displayed. 

 

Click the Ellipsis button and browse to the application that needs to be executed.  
Select the application and click the Open button.  Click OK to save the changes. 

Config Change Report Tab 

When editing a Job that executes a Report showing the changes between Configs, 
the Config Change Report tab will be displayed. 
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Select the type of Config Change Report to generate.  The default selection 
(Compare most recent Download the last Baseline Config) will display all the 
differences between the last Baseline Config, and the most recent Downloaded 
Config. 

The second option, Compare the most recent Download to the Configuration on a 
specific Date, will show all differences between the most recent Downloaded 
Config and a Configuration on the specified date.   

¤  If there was no Config downloaded on the specified date, the next Config after that date will 
be used for the comparison. 

The last two options will show all changes made to a device configuration that 
have occurred during a specific date range. 

Check Show detailed changes to display the differences between each 
configuration file separately.  This will show each change from one config to the 
next.  For example, if there were 4 configuration changes made in a specific date 
range, the Report will show the differences in the first config compared to the 
second config, and then show the differences in the second config compared to the 
third, and so on.  The Report will be grouped by date, showing all changes made 
on each day. 
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Viewing Job Logs 
To view a Job’s log, the list of Job’s must first be displayed.  To display the list of 
Jobs, click the  button on the toolbar, or select Display/Edit Jobs from the 
Schedule menu.  Right-click on a Job and select View Selected Job’s Log. 





 

   

Chapter 9: Settings 
SolarWinds Cirrus Configuration Management has a large amount of 
customizable settings.  These settings range from how Nodes are listed, to how 
buttons and toolbars are displayed.  To access the Configuration Management 
Settings, click the  button, or select Settings from the File menu. 

Node List 
The Node List settings appear first in the list, and are used to determine how the 
Nodes are grouped, and what properties are to be displayed in the Node List. 

 

By default, only the Node Name is displayed in the list, but additional fields can 
be added such as IP Address, System Location, System Contact, and more.  
Custom Properties can also be displayed in the Node List. 

¤  For more information regarding Custom Properties, please refer to the Custom Properties 
section in Chapter 3: Managing Nodes on page 28. 

Adjusting the Show all Configs for each Node in the Node List slider will change 
how many configuration files appear under each node.  With the slider all the way 
to the right, all configuration files will be displayed. 

¤  Adjusting the slider to show less than all Configs will not delete any files from the database. 

Use the last dropdown list to determine how to automatically expand the Node 
List when Cirrus is opened. 
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Security 

 
The Security category is used to determine how to protect the data stored within 
Cirrus.   To set a password to use Cirrus, check the box Require a password to use 
Cirrus Configuration Management.  Enter a password on both lines to ensure it is 
typed correctly.  In the Hide / Encrypt Passwords section, select the options needed 
to secure the data in the Cirrus database. 

When a password is set for Cirrus, each time the application is launched, the user 
will be prompted to enter the password before being granted access to the 
program. 

 

¤  The Application Password is unique to each database.  If Cirrus is installed on more than one 
machine, if each installation is sharing the same database, the password will be the same on 
each box. 
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Global Macro Settings 
The Global Macro settings are used to set the default Community String, Login 
Information, and Transfer Protocol.  When adding new Nodes, the default settings 
will be used unless otherwise specified. 

Community String 

 

Enter the default SNMP Community String in the text box provided.  To set all 
Nodes in the Cirrus database to the new default SNMP Community string, click 
Reset all devices to ${GlobalCommunity}. 

Login Information 
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Enter the default Login Information using the text boxes provided.  To set all 
Nodes in the Cirrus database to the new default Login Information, click Reset all 
Devices to use Global Login Settings. 

Transfer Protocols 

 

Enter the Global Communication Protocols using the text boxes provided.  To set 
all Nodes in the Cirrus database to the new Global Communication Protocols, 
click Reset all Devices to use Global Protocol Settings. 

Notification Defaults 
The Notification Default settings are used to determine what email addresses and 
servers to use when sending Job completion notifications. 
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Email Defaults 

 

Enter the From Name, Reply Address, and Subject lines in the text boxes 
provided.  Enter any default email address in the appropriate boxes. 

SMTP Server 

 

Add the Hostname or IP Address of the email server for Cirrus to send email 
messages to.  Set the SMTP Port Number in the text box provided.  Port 25 is the 
default port for SMTP. 

If the email server requires authentication, check the SMTP Authentication box and 
enter a Username and Password. 
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Custom Properties 

 

Cirrus includes the ability to add Custom Properties to each Node.  Custom 
Properties are additional fields such as country, building, asset tag, serial number, 
etc. that can be defined and stored in the Cirrus database. 

Cirrus provides a collection of the most commonly utilized properties to choose 
from, or new properties can be created.  Once a custom property is defined, the 
properties can be edited in the Node Details of each device. 

Select a property from the drop-down list or type in a new property, and then click 
the Add New Property button to create the Custom Property. 

Once a Custom Property exists, the field will be displayed in Node Details.  To 
edit the Custom Properties, right-click on a node or group of nodes and click Edit 
Selected Nodes or Edit Multiple Nodes.  The new Custom Properties will be 
displayed at the bottom of the Node Details. 
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Reports 

 

The Reports category is used to create a new Report, edit an existing Report, or 
delete a Report.  To edit a Report, select the Report and click Edit Selected Report.  
For details on how to edit a Report, please refer to Creating and Editing Reports in 
Chapter 7: Reports on page 70. 

Scheduled Jobs 

 

The Scheduled Jobs category is used to specify which columns are displayed when 
viewing the Scheduled Jobs list.  Use the appropriate arrow buttons to add / 
remove fields, and to adjust the order of the layout. 
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Node Details Window 
The Node Details Window settings are related to what is displayed when editing 
device details. 

Node Details 

 

Check this box to display the Assigned Macros column in Node Details. 

Interfaces 

 

Use this slider to stipulate how often the Interface List is updated automatically 
when viewing Interface statistics on the Interfaces tab within Node Details. 
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Device Inventory 

 

The Device Inventory category is used to establish which statistics will be collected 
when performing Inventory on Nodes. 

Ping Window 

 

The Ping Window category is used to specify which columns are displayed when 
viewing the Ping results.  To group the Nodes listed in the Ping Window, use the 
dropdown list at the top to select what to group the Nodes by.  Use the 
appropriate arrow buttons to add / remove fields, and to adjust the order of the 
layout. 
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Node Monitoring 

 

The Node Monitoring category is used to establish if and how nodes are polled for 
status.  Check the box at the top to enable Node Status monitoring.  Use the sliders 
to specify how often each Node is polled, Maximum polls per second, and how 
often each Node’s details are rediscovered.  To play sounds when a Node goes up 
or down, check the Play Sounds when Nodes go Up or Down box. 

Search Configs 

 

The Search Configs category is used to specify which columns are displayed when 
viewing the Search results.  To group the Nodes listed in the Search Results 
Window, use the dropdown list at the top to select what to group the Nodes by.  
Use the appropriate arrow buttons to add / remove fields, and to adjust the order 
of the layout. 
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Configs 
The Configs category is used to determine how configuration files are displayed 
when editing, and how the files are archived. 

Config Editor 

 

The Config Editor category is used to specify how the configuration files are 
displayed when editing.  Click the Select Font button to select the preferred font 
style. 

When saving changes to configuration files, only the last revision is saved by 
default.  Alternately, to save all revisions, uncheck the When configs are edited, 
only retain the last revision box. 
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Config Transfers 

 

Adjust this slider to set how many simultaneous downloads and uploads can be 
executed. 

Config Comparisons 

 

Check this box to show the Comparison Overview when comparing to 
configuration files.  The Comparison Overview scales to fit the size of the window 
allowing for an overview of the entire comparison.  Click anywhere on the 
Comparison Overview to jump to the associated section of the configs being 
compared. 
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Config Mirror 

 

The Config Mirror category is used to determine if and where mirror copies of 
configuration files will be saved.  Check the Save a copy of each Config to the 
Config-Archive folder when it is downloaded box to enable Config Mirror copies.  
Click the Ellipsis button next to the first text box to select a path to save the 
configuration files to.  In the second text box, create a folder name template to 
organize the configs.  Refer to Appendix C: Macros on page 145 for a full list of 
macros that can be used to create a folder structure. 

Click the Export all Configs to the Config-Archive directory now button to copy all 
configs from the database to the mirror location. 
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Network 
The Network settings are used to determine timeout and retry settings. 

ICMP Settings 

 

Adjust the ICMP Packet Timeout slider to establish how long Cirrus waits before 
determining an ICMP packet has been lost. 

To change the Data portion of the ICMP packet, add or remove text from the text 
box provide.  As text is added or removed, the number of bytes included in the 
packed is updated automatically. 
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SNMP Settings 

 

Adjust the SNMP Packet Timeout slider to establish how long Cirrus waits before 
determining an SNMP packet was not received. 

Adjust the SNMP Retries slider to determine how many times Cirrus will resend 
the SNMP request. 

Telnet Settings 

 

Adjust the Telnet Connection Timeout slider to establish how long Cirrus waits 
before timing out a Telnet connection. 
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Macros 

 

Additional Global Macros can be created to use with device properties, scripts, 
Jobs and more.  To edit a macro’s value, click in the Value area of the macro and 
just start typing.  To create a new macro, click the Add New Global Macro button. 

 

Give the macro a name and click OK to save the macro. 

Tools and Actions 
The Tools and Actions category is used to add or edit actions that can be accessed 
from the tool bar or right-click menus. 
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Tools 

 

The Tools listed here appear in the right-click menu and in the Tools menu.  To 
remove a Tool, select the Tool from the list and click Delete.  To edit a Tool, select 
the Tool from the list and click Edit. 

 

To create a new Tool, click the New button and then give the Tool a name.  Select a 
Program using the ellipsis button to the right of the Program text box.  Click the 
Change Toolbar Image button to select a different icon for the Tool.  Check the Add 
new tool to Tools menu box to include the new Tool in the right-click and menu list.  
Click OK to save the changes. 

¤  Details on how to customize toolbars can be found in Appendix B: Custom Toolbars. 
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Show Commands 

 

The Show Commands listed here appear in the right-click menu and in the Show 
menu.  To remove a Show Command, select the command from the list and click 
Delete.  To edit a Show Command, select the command from the list and click Edit. 

 

Type in the execute command and click the ellipsis button to select a different icon 
for the Show Command if necessary.  Check the Add to Show menu box to include 
the new Show Command in the right-click and menu list.  Click OK to save the 
changes. 

¤  Details on how to customize toolbars can be found in Appendix B: Custom Toolbars. 
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MIBs 

 

The MIBs listed here appear in the right-click menu, the MIBs menu, and on the 

toolbar when clicking the  button.  To remove a MIB, select the MIB from the 
list and click Delete.  To edit a MIB, select the MIB from the list and click Edit. 

 

The MIBs dialog is displayed where a new OID can be selected, and / or the name 
of the MIB can be changed.  Click the Change Toolbar Image button to select a 
different icon for the MIB.  Click OK to save the changes. 

To create a new MIB, click the New button.  Give the MIB a name and then type the 
MIB Name or OID into the second text box.  There is a dropdown list of the most 
common used MIBs to choose from. 
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Click the Change Toolbar Image button to select a different icon for the MIB.  Check 
the Add this new item to MIBs menu box to include the new MIB in the right-click 
and toolbar list.  Click OK to save the changes. 

¤  Details on how to customize toolbars can be found in Appendix B: Custom Toolbars. 

MIB Browser 

 

Use this category to select either the Internal or External MIB Browser.  To use the 
External MIB Browser, a SolarWinds Engineer’s Edition toolset must be installed 
on the same machine. 

+  The Desktop version of Cirrus does not include the internal MIB Browser. 

To limit the Internal MIB Browser to SNMP Version 1, check the box in the SNMP 
Version section.  Limiting the MIB Browser to SNMP Version 1 queries will correct 
some of the problems experienced with older SNMP devices.  However, SNMP 
Version 1 is much slower than SNMP Version 2. 

Advanced 
The Advanced options are used to determine how Cirrus is displayed.  The 
Advanced Tabbed Interface allows the user to move tabs to different locations in 
the application, as well as creating new horizontal or vertical tab groups.  The 
Advanced Tabbed Interface allows for considerably more complex displays. 
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Application Style 

 

Choose either Traditional Multiple Document Interface or Advanced Tabbed Interface 
for the display preference, and click OK to save the changes. 

Toolbars 

 

The Toolbars category is used to select the style of toolbars to display.  Simply click 
the button of the preferred style. 
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Session Tracing 

 

Session Tracing creates a log file of each telnet session and places the file in the 
Configuration-Management\Session-Trace folder.  Check the Turn on Session 
Tracing box to enable logging of Session Traces.



 

   

Chapter 10: Database Manager 
The Database Manager can be used to perform queries, view database and table 
details, export data, and edit database values. The Database Manager can also be 
used to repair, compact, restore, or backup the database. 

Getting Started 
The Database Manager is opened from the Windows Start Menu: Start à  
SolarWinds Network Performance Monitor à  Database Utilities à  SQL Database 
Manager.  The SolarWinds Database Manager opens to display a splash screen 
depicted in the illustration that follows. 

 
The Splash Screen provides additional application information and presents a 
collection of buttons that can be used to perform the software's most common 
functions. This functionality is also available from the application menu and 
toolbar. 

Adding a Server 
After installing Cirrus, the SQL server that is to be managed needs to be added to 
the Database Manager application.  To do this, select Add Server from the toolbar 
(or select File à  Add Server from the menu). The NetPerfMon Database Manager 
dialog is displayed. 
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Select the SQL server from the drop down or enter the IP address of the SQL 
Server machine.  Use the radio buttons provided to select the login style.  Use 
Windows NT Integrated Security to automatically pass the windows user ID and 
password to the SQL server, or select to use a separate SQL Server user ID and 
password.  Upon selecting the later option, the dialog will dynamically change to 
display text boxes for entry of the SQL Server user ID and password.  After 
making the selections, click Connect to Database Server.  The selected server and 
associated databases will be displayed in the tree structure of the Database 
Manager window. 

Database Backup 
It is very important to periodically back up the Cirrus database.  To back up the 
database, right-click on the database name in the tree of the Database Manager 
window and choose Backup Database. 

The Backup Database dialog prompts to enter a description of the database backup 
and specify a path and filename for the backup file.  Enter the requested 
information, and give the backup a name, typically, C:\Program 
Files\SolarWinds\Data\ConfigurationManagement.BAK. Refer to Creating a 
Database Maintenance Plan on page 113, for details on how to schedule a regular 
database backup. 

¤  Ensure that the target location for the database backup has sufficient available disk space. 

Restore a Database 
To restore a database from backup, open the Database Manager and select 
Database à  Restore Database (or right-click the SQL Server in the tree and select 
Restore Database from the list).  The Restore Database dialog is displayed.  Use the 
Ellipsis button to navigate to the location of the desired database, or enter a valid 
SQL Backup database name and complete path in the text box.  Typically 
C:\Program Files\SolarWinds\Data\ConfigurationManagement.BAK. 
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'  Use the Verify button to check that a valid SQL Backup database name has been specified. 

 
Upon selecting a database, the remaining fields will be auto-filled.  The Database 
Name field is populated with the name SQL will use to refer to the specified 
database.  The remaining two fields displayed are the data files (.mdf is the data 
file and .ldf is the log file) that the database is comprised of.  The values that are 
provided can be changed, noting that SQL does not create directories; therefore 
the specified path must already exist.  Also keep in mind that a database that is 
currently in use cannot be restored.  Click OK to restore the selected database. 

Compact a Database 
The database compact procedure can be run to remove white space, reindex, and 
shrink the database.  SolarWinds recommends compacting the database as it 
approaches 1.5 -1.6 GB in size, as the max size of the SQL Desktop Engine that 
ships with Cirrus is 2GB.  Database compaction can be performed within Database 
Manager by selecting Database à  Compact Database (or by right-clicking the 
database name and selecting Compact Database from the list).  Upon completion, a 
dialog listing the size of the database before and after compaction is displayed. 

¤  The same value displayed in the before and after size is an indicator that there is not enough 
free space in the database to rearrange data.  Use the Compact/Rebuild Indexes option on 
individual tables in order to free up enough space for the database compaction to occur. 

Compact Individual Tables 
Individual tables within a database may be compacted from the Database 
Manager application.  Right-click on the desired table and select Compact/Rebuild 
Indexes from the list.  A dialog listing the before and after size of the table is 
displayed upon completion.  Click OK to close the dialog. 
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View Database Details 
Details pertaining to the selected database can be viewed in Database Manager by 
right-clicking the database name and selecting Database Details from the list (or by 
selecting Database à  Database Details from the menu).  The Database Details page 
is displayed with the Properties tab open.  SolarWinds recommends monitoring 
the value in the Total Space Used field.  When the database size approaches 1.5 or 
1.6 GB, the Compact procedure outlined on page 111 should be run, as the 
maximum size of the SQL Desktop Engine that ships with Cirrus is 2GB.  The Last 
Backup field should also be noted to ensure that a regular database maintenance 
plan is being adhered to.  If this field is blank, a backup of the database should be 
created, and refer to Creating a Database Maintenance Plan on page 113. 

View Table Details 
Database Manager's Table Details page is comprised of three tabs used to display the 
table's property, column, and index information.  View the Table Details by 
selecting Table à  Table Details from the menu (or by right-clicking the table name 
in the tree and selecting Table Details from the list). 

The Properties tab includes general statistics pertaining to the table size and 
creation date.  The Columns tab describes the columns in the table, the keys, and 
field types, while the Indexes tab lists the indexes used within the table.  The table 
may also be queried by selecting the Query button included on the top of the 
display.  A default SQL statement is provided, as well as radio buttons for 
displaying the data in read or read/write view.  Special care should be taken while 
editing database values as the integrity of the database could easily be 
compromised. 

Exporting Data 
The data displayed in the query view of the Database Manager can be exported to 
one of several formats.  To export the query data, select File à  Export à  Export to *, 
substituting the desired format for *.   Available formats include: Comma 
Delimited, Text, HTML, Excel, or PDF.  The Select Fields dialog will be presented 
prompting for the data fields to be included in the export.  Upon selection, the Save 
As dialog will be displayed.  Navigate to the desired location, specify a name, and 
click Save. 

¤  The Export directly to Excel option saves the file with the .xls extension and opens the file in 
Excel for immediate use.  The Export to Excel option saves the file with the .xls extension. 
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Editing Database Fields 
Database fields may be edited within the Database Manager application from the 
query view.  It is very important to exercise great care when editing database 
values, as the integrity of the database could be jeopardized.  To edit a field, right-
click on the desired table and select Query Table from the list.  Use the provided 
SQL statement or enter a custom statement in the display.  Click the Refresh 
button to display the query results in table view.  Select the Read/Write radio 
button included at the top of the display to enable the ability to edit the fields. 

Detach a Database 
The database can be detached in order to leave the data files (.mdf is the data file 
and .ldf is the log file) that the database is comprised of in tact.  Detaching a 
database removes the reference from the SQL Server allowing the files to be 
moved to different locations safely.  Open Database Manager and select Database 
à  Detach Database from the menu or right-click the database name and select 
Detach Database from the list. 

¤  SolarWinds does not recommend using the Detach Database option to move a database to a 
new SQL Server. Please use the Backup and Restore procedures described on page 110. 

Creating a Database Maintenance Plan 
A database maintenance plan can be created that will automatically compact and 
backup the database on a scheduled basis.  To create a database maintenance plan 
for the Cirrus database, follow these steps: 

1. In Database Manager, right-click on the database, and choose Database 
Backup Schedule. 

2. The Database Maintenance Wizard will start. 

3. Select the frequency with which to run the backup, set the time for it to 
run, and click Next. 

4. Select the check box to compact and shrink the database before the 
backup (recommended). 

5. Choose the location where the database backup files are to be created 
and the backup reports stored.  Click Finish to continue. 

¤  SQL Server Agent must be running in order for the database maintenance plan to be executed. 
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Using Enterprise Manager 
If a licensed copy of SQL Server 2000 Standard or Enterprise Edition already 
exists, Enterprise Manager can be used to maintain the Cirrus database instead of 
the SolarWinds Database Manager.  SolarWinds recommends contacting a DBA 
and referencing the documentation that Microsoft provides on Enterprise 
Manager for instructions on using it to manage a SQL 2000 database. 

If a DBA is not available, and would still like to use Enterprise Manager to set up a 
maintenance plan for the Cirrus database, follow these steps: 

1. Open Enterprise Manager and select the SQL Server group in the left 
pane. 

2. From the menu, choose Action à  New SQL Server Registration. 

3. Click Next to begin the SQL Server Register Wizard. Next, choose the 
Cirrus Server/Instance Name from the list and click Add.  If the SQL 
Server does not show up in the list, it can be entered manually. 

4. Choose the type of authentication that will be used to connect to the 
SQL server.  Select the Server Group to which the SQL Server should 
be added and click Finish. 

5. Expand the items on the left until the Cirrus database is visible. 

6. Right-click on the database and choose All Tasks à  Maintenance Plan. 

7. The Maintenance Plan Wizard will walk through building a 
maintenance plan for the Cirrus database.  Click Next to start the 
wizard. 

8. Select the database to which the maintenance plan should apply and 
click Next.  In most cases, the only database that needs to be selected is 
the Cirrus database (Configuration-Management). 

9. Configure the database backup schedule.  It is recommended that the 
database be backed up as a regular part of the maintenance plan and 
that the integrity of the backup is checked when complete.  Normally, 
it is recommended that the backup job is run nightly.  Click Next to 
continue. 

10. Configure the directory where the database backups should be stored. 
Be sure to specify a location with sufficient free space.  Also, be sure to 
specify how long to keep the database backups in the Remove Files 
Older Than section.  Click Next to continue. 
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11. Configure the transaction log backup.  It is not normally necessary to 
back up the transaction log as a part of the maintenance plan.  Click 
Next to continue. 

12. Configure the report to be generated during maintenance.  These 
reports are especially important if there is a problem.  Be sure to 
specify the length of time to keep reports in Delete Text Report Files 
Older Than.  Click Next to continue. 

13. Configure the maintenance plan history.  It is not typically necessary to 
write a maintenance plan history.  Click Next to continue. 

14. Finally, choose a name for the maintenance plan and click Finish. 

For additional help with using Microsoft’s Enterprise Manager, please visit the 
Microsoft Support Website at http://support.microsoft.com

http://support.microsoft.com




 

   

Chapter 11: Cirrus Scenarios 
This chapter discusses several different scenarios that demonstrate how to use 
Cirrus in different network environments. 

Updating the Login Banner 
Various situations will arise prompting a change to the Login Banner for a router, 
switch, or firewall.  With Cirrus, this can be performed on one Node, or even a 
group of Nodes all at once. 

To update the Login Banner for a Node or group of Nodes, a command script must 
first be created.  It is always a good idea to backup the running config prior to 
making any changes, so right-click on the Node or group of Nodes that are to be 
updated, and click Download Configs.  Click the Download button to download and 
save the configuration files to the database. 

Right-click on a Node or group of Nodes and select Execute Command Script to 
open the Execute Script dialog. 

 

Ensure the Nodes that are to be updated are listed in the top window.  If more 
Nodes need to be added, click the Add Devices button. 
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Type the command script that is to be executed or load an existing script by 
clicking the Load Script button.  Once satisfied with the command script, click the 
Execute Command Script button. 

 

The Results tab will be opened automatically and the results of the script will be 
displayed as the output is received. 

To verify the script was executed successfully, open a Telnet session to one of the 

updated Nodes by selecting the Node in the Node List and clicking the  button 
on the toolbar.  A new window with a command prompt Telnet session will be 
opened displaying the new Login Banner. 
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Another way to verify the script was executed successfully is to download the 
running config and compare it to the previous running config.  Right-click on the 
Node or group of Nodes and download the running configs again, and check the 
box that says Compare to last Config Downloaded, then click the Download button. 

When the download completes, a comparison window will open automatically, 
and the change to the Login Banner will be highlighted in Yellow if it is different 
than the previous Login Banner, or highlighted in Red and Green if there was no 
Login Banner previously. 

Scenario References 

Chapter Section Page 

Chapter 4: Managing Configs Downloading Configs 31 

Chapter 4: Managing Configs Comparing Configs 34 

Chapter 5: Command Scripts Executing Command Scripts 60 
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Configuring an Automated Nightly Backup 
One of the great features of Cirrus is the ability to schedule daily backups of 
configuration files.  SolarWinds has provided an Example Job with Cirrus that 
downloads the configuration files for all Nodes in the database every night.  This 
Example Job can be modified to suit specific needs, or a new job can be created 
from scratch.  This Scenario will demonstrate how to create the Nightly Backup 
Job from scratch. 

To setup an automatic Nightly Backup for all Configs, select Create New Job from 
the Schedule menu.  Select Download Configs from Devices and then click Next à . 

 

Give the Job a name, click Next à , then enter the time of day and choose the Job 
frequency, and then click Next à . 
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Enter the Windows User Information and then click Finish.  The Edit Job dialog is 
now displayed.  On the Nodes tab, All Nodes is selected by default.  If this Job is 
only for a specific group of Nodes, click the All Nodes in the Database button to 
specify a list of Nodes or a Selection Criteria.  Select what types of configuration 
files to download on the Download Config tab, and set any Notification actions on 
the Notification tab.  Click OK to save the changes. 

 

Scenario References 

Chapter Section Page 

Chapter 8: Scheduling Tasks Creating a New Job 75 

 

Changing Community Strings on Several Routers 
This Scenario shows how to replace the public read-only community string with a 
new read-only community string on several routers at the same time. 

To update the community string for a group of Nodes, a command script must 
first be created.  It is always a good idea to backup the running config prior to 
making any changes, so right-click on the group of Nodes that are to be updated, 
and click Download Configs.  Click the Download button to download and save the 
configuration files to the database. 

Right-click on a Node or group of Nodes and select Execute Command Script to 
open the Execute Script dialog. 
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Ensure the Nodes that are to be updated are listed in the top window.  If more 
Nodes need to be added, click the Add Devices button. 

Type the command script that is to be executed or load an existing script by 
clicking the Load Script button.  Once satisfied with the command script, click the 
Execute Command Script button. 

The Results tab will be opened automatically and the results of the script will be 
displayed as the output is received. 

To verify the script was executed successfully, download the running config and 
compare it to the previous running config.  Right-click on the group of Nodes and 
download the running configs again, and check the box that says Compare to last 
Config Downloaded, then click the Download button. 

When the download completes, a comparison window will open automatically, 
and the change to the community string will be highlighted in Red and Green. 

Scenario References 

Chapter Section Page 

Chapter 4: Managing Configs Downloading Configs 31 

Chapter 4: Managing Configs Comparing Configs 34 

Chapter 5: Command Scripts Executing Command Scripts 60 
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Changing Wireless Settings on All Access Points 
This Scenario shows how to make a change in a Wireless Access Point’s web 
interface, and then push that same change to additional Access Points by 
uploading only the changed lines in the configuration file. 

It is always a good idea to backup the running config prior to making any 
changes.  To do this, right-click on the group of Access Points, and click Download 
Configs.  Click the Download button to download and save the configuration files 
to the database. 

To open an Access Point’s web interface, right-click on the Node in the Node List 
and select Browse Node.  Make the necessary changes in the web GUI, and then 
close the browser tab. 

 

Next, download the new running config and compare it to the previous running 
config.  Right-click on the Node and download the running config again, and be 
sure to check the box that says Compare to last Config Downloaded, then click the 
Download button. 

When the download completes, a comparison window will open automatically, 
and the change to the configuration will be highlighted in Yellow if it is different 
than the previous configuration, or highlighted in Red and Green if the setting did 
not exist previously. 
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Highlight the line(s) that has changed, right-click and select Create Snippet from 
Selection.  A new Config Snippet is created and added to the list of Config 
Snippets.  Open the Config Snippets window by clicking on the Config Snippets tab 
located on the right side of the application by default. 

Right-click on the Snippet and click Upload to Devices.  Ensure the Nodes that are 
to be updated are listed here.  If more Nodes need to be added, click the Add 
Devices button. 

 

Click the Create Upload Script button to display the Execute Script dialog.  Click the 
Execute Command Script button to upload the change to the remaining Access 
Points. 

The Results tab will be opened automatically and the results of the script will be 
displayed as the output is received. 

Once the script has finished executing, download the new running configs from all 
the updated Access Points to add the new configuration files to the Cirrus 
database. 

Scenario References 
Chapter Section Page 

Chapter 4: Managing Configs Downloading Configs 31 

Chapter 4: Managing Configs Comparing Configs 34 

Chapter 4: Managing Configs Config Snippets 41 

Chapter 4: Managing Configs Uploading a Config Snippet 47 

Chapter 5: Command Scripts Executing Command Scripts 60 
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Changing an Interface’s Description 
To update an Interface’s description for a Node or group of Nodes, a command 
script must first be created.  It is always a good idea to backup the running config 
prior to making any changes, so right-click on the Node or group of Nodes that are 
to be updated, and click Download Configs.  Click the Download button to 
download and save the configuration files to the database. 

Right-click on a Node or group of Nodes and select Execute Command Script to 
open the Execute Script dialog. 

 

Ensure the Nodes that are to be updated are listed in the top window.  If more 
Nodes need to be added, click the Add Devices button. 

Type the command script that is to be executed or load an existing script by 
clicking the Load Script button.  Once satisfied with the command script, click the 
Execute Command Script button. 
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The Results tab will be opened automatically and the results of the script will be 
displayed as the output is received. 

To verify the script was executed successfully, right-click on the Node in the Node 
List and select Edit Selected Nodes.  Click the Interfaces tab and then select Interface 
/ Port Configuration and then click the Refresh button to display the Interfaces 
along with their Interface Descriptions. 

 

Another way to verify the script was executed successfully is to download the 
running config and compare it to the previous running config.  Right-click on the 
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Node or group of Nodes and download the running configs again, and check the 
box that says Compare to last Config Downloaded, then click the Download button. 

When the download completes, a comparison window will open automatically, 
and the change to the Interface Description will be highlighted in Yellow if it is 
different than the previous Interface Description, or highlighted in Red and Green 
if there was no Interface Description previously. 

 

Scenario References 

Chapter Section Page 

Chapter 3: Managing Nodes Editing Nodes 25 

Chapter 4: Managing Configs Downloading Configs 31 

Chapter 4: Managing Configs Comparing Configs 34 

Chapter 5: Command Scripts Executing Command Scripts 60 
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IOS and Firmware Upgrades 
IOS images can be uploaded using Cirrus’s internal scripting engine.  These image 
files can be transferred via TFTP, FTP, HTTP, or any other transfer protocol. 

+  Because managing IOS images can be very complex, it is recommend that the user follow the 
upgrade guidelines outlined by the hardware manufacturer. 

For this example, the SolarWinds TFTP Server (included with Cirrus) will be used 
to transfer the IOS image to the router.  The TFTP Server must be running and 
configured to send and receive files.  Also, the IOS image file must reside in the 
TFTP Root Directory. 

To push an IOS image to a router, a command script must first be created.  It is 
always a good idea to backup the running config prior to running any scripts, so 
right-click on the Node that is to be updated, and click Download Configs.  Click the 
Download button to download and save the configuration to the database. 

Right-click on the router and select Execute Command Script to open the Execute 
Script dialog. 

 

Ensure the Nodes that are to be updated are listed in the top window.  If more 
Nodes need to be added, click the Add Devices button. 

Type the command script that is to be executed.  The script should mirror 
commands entered when manually uploading an IOS image using the command 
prompt.  For example, when uploading an IOS image via a TELNET session, the 
prompt requires the user to enter “y” to confirm the transfer.  Add one line to the 
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script that simply has “y” (without quotes) with a carriage return (ENTER key) at 
the end of the line.  Once satisfied with the command script, click the Execute 
Command Script button. 

'  A previously saved script can be loaded by clicking the Load Script button. 

The Results tab will be opened automatically and the outcome of the script will be 
displayed as the output is received. 

 

¤  This task can be scheduled to run at a later time/date.  Save the script and then refer to Chapter 
8: Scheduling Tasks for information on how to schedule a Job to Execute a Command Script.  
When creating the Job, load the script from the saved file. 

Scenario References 

Chapter Section Page 

Chapter 4: Managing Configs Downloading Configs 31 

Chapter 5: Command Scripts Executing Command Scripts 60 





 

   

Appendix A: Software License 
Key 
During installation, a window with the Install Software License Key screen 
(illustrated below) will be displayed prompting for the user’s name, E-mail 
address, phone number, Customer ID, and Password.  If this is the case, follow the 
instructions below.  Once the software has been registered, proceed with the 
installation. 

 

Option 1 - Internet Connection:  If the computer Cirrus is installed on is 
connected to the Internet and not behind a proxy server, enter the information on 
the Install Software License Key screen and click Continue.  The SolarWinds license 
registration server will issue a license key that will allow Cirrus to operate. 

 

Option 2 - No Internet Connection:  If the computer Cirrus is installed on is not 
connected to the Internet, the system will be unable to be authenticated on 
SolarWinds' license registration server.  Click the Skip This and Enter Software 
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License Key Now button on the Install Software License Key screen.  The following 
screen will be displayed. 

 

A license must be obtained using a computer that is connected to the Internet. 
Login to the customer area of the SolarWinds website at 
http://solarwinds.net/Keys, and then click Software Keys from the Customer Area 
menu.  Choose the product that needs a key, and follow the instructions on the 
page to obtain a key.  The key can then be entered in the Enter Software License 
Key... text box.  Click Continue to complete the Software License Key installation. 

 

 

http://solarwinds.net/Keys


 

   

Appendix B: Custom Toolbars 
The toolbars and menus can be customized to meet individual needs.  To 
customize the toolbars or menus, right-click anywhere on the toolbar at the top of 
the application and select Customize. 

 

The Configuration Management Customization dialog is displayed with five tabs; 
Toolbars, Commands, Show Commands, MIBs, Tools, and Options. 
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Toolbars Tab 

 

This tab is used to determine which toolbars will be displayed.  Also, toolbars can 
be created, edited or deleted. 

To stretch a toolbar across the entire window, select the toolbar from the list and 
check the Stretch Toolbar box. 

To reset an individual toolbar to its original state, select the toolbar from the list 
and then click the Reset button. 

Click the Reset All Toolbars and Menus button to restore every toolbar and menu to 
its original state. 

To create a new toolbar, click the New button and then give the toolbar a name.  
An empty toolbar will be added.  Add commands, MIBs, Show Commands, and 
Tools as needed.  Refer to each section in this Appendix for specific instructions on 
how to add actions and tools to the new toolbar. 

Commands Tab 
The Commands tab is used to add commands to a toolbar or menu. 
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For example, there is no Open Database option in the default File menu.  To add it, 
select the File Category on the left side and then drag the Command Open 
Database to a location on the File menu. 

 

A black divider bar will show up between the menu items as the mouse cursor 
moves up and down the menu.  Place the divider bar between New Configuration 
Management Database and Startup Wizard and release the mouse button.  The Open 
Database Command now appears in the File menu. 
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MIBs Tab 

 

The MIBs listed here appear in the right-click menu, the MIBs menu, and on the 

toolbar when clicking the  button.  To remove a MIB, select the MIB from the 
list and click Delete.  To edit a MIB, select the MIB from the list and click Edit. 
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The MIBs dialog is displayed where a new OID can be selected, and / or the name 
of the MIB can be changed.  Click the Change Toolbar Image button to select a 
different icon for the MIB.  Click OK to save the changes. 

To create a new MIB, click the New button.  Give the MIB a name and then type the 
MIB Name or OID into the second text box.  There is a dropdown list of the most 
common used MIBs to choose from. 

 

Click the Change Toolbar Image button to select a different icon for the MIB.  Check 
the Add this new item to MIBs menu box to include the new MIB in the right-click 
and toolbar list.  Click OK to save the changes. 
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Show Commands Tab 

 

The Show Commands listed here appear in the right-click menu and in the Show 
menu.  To remove a Show Command, select the command from the list and click 
Delete.  To edit a Show Command, select the command from the list and click Edit. 

 

The Show Command dialog is displayed where the command and the name of the 
Show Command can be changed.  Click the ellipsis button to select a different icon 
for the Show Command if necessary.  Click OK to save the changes. 

To create a new Show Command, click the New button and then give the 
command a name. 
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Type in the execute command and click the ellipsis button to select a different icon 
for the Show Command if necessary.  Check the Add to Show menu box to include 
the new Show Command in the right-click and menu list.  Click OK to save the 
changes. 

Tools Tab 

 
The Tools listed here appear in the right-click menu and in the Tools menu.  To 
remove a Tool, select the Tool from the list and click Delete.  To edit a Tool, select 
the Tool from the list and click Edit. 
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The Tools dialog is displayed where the Program and the name of the Tool can be 
changed.  Click the Change Toolbar Image button to select a different icon for the 
Tool if necessary.  Click OK to save the changes. 

To create a new Tool, click the New button and then give the Tool a name. 

 

Select a Program using the ellipsis button to the right of the Program text box.  
Click the Change Toolbar Image button to select a different icon for the Tool.  Check 
the Add new tool to Tools menu box to include the new Tool in the right-click and 
menu list.  Click OK to save the changes. 
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Options Tab 

 

The Options tab is used to select the Toolbar Style and Menu Animations.  To 
change the Toolbar Style, simply click the button of the Style desired.  To select a 
Menu Animation, select a Style from the dropdown list to change how menus are 
displayed when accessed. 





 

   

Appendix C: Macros 
Cirrus Configuration Management uses a similar macro system as the one in 
Orion Network Performance Monitor.  Macros always begin with a dollar sign 
and curly brace ${  and always end with a curly brace  }. 

Macros can be used within almost any custom property.  They can also be used in 
any of the user editable system properties. 

Macros can also be nested and recursive.  In other words, a single macro can refer 
to a Node property that contains more macros that then contain more macros.  The 
following example demonstrates nested macros. 

 
Node Property Value of Property 
Location Rack ${Rack} on ${Floor} floor of 

${Building} - ${SysLocation} 
Building Building C 
SysLocation Data Center A 
Rack 15 
Floor Second 

 
The database value of Location is “Rack ${Rack} on ${Floor} floor of ${Building} - 
${SysLocation}”, but the displayed value of Location would be “Rack 15 on 
Second floor of Building C – Data Center A”. 

Node Macros 
All fields in the Nodes table can be used as Macros.  This includes any custom 
properties added to the Nodes table. 

 
Nodes Table Field Description 
NodeID Unique ID assigned to each Network Node 
NodeCaption Displayed name for the Node. The default for 

NodeCaption is a macro.  “${SysName}” 
NodeGroup Group that this Node belongs to. Some group 

examples might be … “Routers”, “Accounting”, or 
simply “${Building}”. The last example refers to a 
custom property named “Building”. 

AgentIP The IP address used when communicating with 
the Node. A router or server may have many IP 
Addresses. This IP address is the one used 
when making Configuration Management makes 
SNMP requests or transfers configs. 
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AgentIPSort Numeric equivalent of the AgentIP. Used for 
sorting by IP Address in reports. 

ReverseDNS Reverse lookup of the AgentIP 
ResponseTime Current response time of the Node in 

milliseconds 
ResponseError “OK” if the Node is responding. An error 

message if the Node is not responding. 
Status Numeric status of the Node. 

1 = Up 
2 = Down 

Community SNMP Community string 
SNMPLevel The version of SNMP supported by the Node. 

0 = SNMP not supported 
1 = SNMP V1 
2 = SNMP V2 
3 = SNMP V3 

SysName System name of the Node. 
SysDescr System description of the Node. 
SysContact System contact information collected from the 

Node. 
SysLocation System location information collected from the 

Node. 
SystemOID System OID discovered from the Node. 
Vendor Hardware vendor of this network Node. 
VendorIcon Name of the Vendor icon used. 
MachineType Type of hardware. This information is discovered 

by SolarWinds Discovery Engine. 
LastBoot Last time the Node rebooted. 
OSImage Operating system running on the Node 
OSVersion Version of the Operating System running on the 

Node 
ConfigTypes Types of Configs supported by this Node 
NodeComments Any comments about this Node entered by the 

user. 
NextDiscovery Time the next complete discovery of this Node is 

scheduled 
NextPoll Time the next poll (up/down and response time) 

is scheduled 
Username Login username 
Password Login password 
EnableLevel Enable level used when transferring configs or 

running scripts 
EnablePassword Enable level password 
ExecProtocol The protocol used when executing scripts. This 

is set to ${GlobalExecProtocol} by default. 
TransferProtocol The protocol used when downloading configs. 

This is set to ${GlobalTransferProtocol} by 
default. 
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Config-Archive Macros 
Cirrus Configuration Management stores all downloaded Configs in a database. It 
can also store a copy of them in the Config Archive directory structure.  The 
directory structure can be specified using any of the previous macros.  

Additional macros can also be used when specifying the Config Archive directory.  
Many of these macros use the system’s localization settings for the current 
language and region. 

Property Description 
DateTime Local date and time in “short date” and local 

time format 
Date Date in “short date” format 
LongDate Date in “long date” format 
MediumDate Date in “medium date” format 
Time Time in “short time” format 
LongTime Time in “long time” format 
MediumTime Time in “medium time” format 
ShortTime Time in “short time” format 
DOW Day of the week (spelled out) 
D Day of the month 
DD Day of the month (with leading zero if needed) 
ABREVIATEDDOW Day of the week in abbreviated format 
LocalDow Day of the week in the local language 
Month Number of the current month 
M Number of the current month 
MM Number of the current month (with leading 

zeros if needed) 
MMM Abbreviated name of the month 
MMMM Name of the month 
LocalMonthName Name of the month in the local language 
DAYOFYEAR Day number of the year 
YYYY 4 digit year 
YY 2 digit year 
YEAR2 2 digit year 
YEAR4 4 digit year 
H Hour 
HH 2 digit hour (with leading zero if needed) 
N Minute 
NN 2 digit minute (with leading zero if needed) 
S Seconds 
SS 2 digit seconds (with leading zero if needed) 
AMPM AM or PM 
CRLF Carriage return – linefeed combination 
ConfigType Type of Config ( running, startup, etc ) 
Caption Caption of the Node (NodeCaption) 
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Command Script Macros 
Command Script Macros are used within Command Scripts as well as Device 
Command Templates.  For information on creating Command Scripts , refer to 
Chapter 5: Command Scripts on page 57. 

Property Description 
ConfigType Value used to specify the type of Config 
CR Carriage Return 
CRLF Carriage Return – Linefeed combination 
DownloadConfig Series of commands used to download a 

Configuration from a device 
EnableIdentifier Only used when a device does not return 

the “#” symbol at the end of a prompt to 
indicate Enable Mode. Value that is 
displayed while in Enable Mode for a device. 

EnterConfigMode Series of commands used to enter the 
Configuration Mode of a device 

ExitConfigMode Series of commands used to exit the 
Configuration Mode of a device 

IPAddress The IP Address of the server Cirrus is 
installed on 

Reboot Series of commands used to reboot the 
device 

RebootAt Series of Commands used to reboot a 
device at a specified time. Use the macros 
listed in the Config-Archive Macros section 
of this Appendix to assign the date and time. 

RESET Series of commands used to set the length 
and pagination of the session 

Running Value used to specify a Running Config type 
SaveConfig Series of Commands used to write the 

Configuration to the devices memory 
Startup Value used to specify a Startup Config type 
Version Series of Commands used to display the 

software version of the device 
 



 

   

Appendix D: Regular 
Expression Pattern Matching 
When editing Comparison Criteria, the following Regular Expressions can be used 
for pattern matching. 

Characters 
Character Description Example 

Any character 
except [\^$.|?*+() 

All characters except the listed special 
characters match a single instance of 
themselves. 

a matches a 

\ (backslash) 
followed by any of 
[\^$.|?*+() 

A backslash escapes special characters to 
suppress their special meaning. 

\+ matches + 

\xFF where FF are 
2 hexadecimal 
digits  

Matches the character with the specified 
ASCII/ANSI value, which depends on the 
code page used. Can be used in character 
classes. 

\xA9 matches © 
when using the 
Latin-1 code page. 

\n, \r and \t 
Match an LF character, CR character and a 
tab character respectively. Can be used in 
character classes. 

\r\n matches a 
DOS/Windows 
CRLF line break. 

Character Classes or Character Sets [abc] 
Character Description Example 

[ (opening square 
bracket) 

Starts a character class. A character class 
matches a single character out of all the 
possibilities offered by the character class. 
Inside a character class, different rules 
apply. The rules in this section are only 
valid inside character classes. The rules 
outside this section are not valid in 
character classes, except \n, \r, \t and 
\xFF 

  

Any character 
except ^-]\ add that 
character to the 
possible matches 
for the character 
class. 

All characters except the listed special 
characters. 

[abc] matches a, b 
or c 
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\ (backslash) 
followed by any of 
^-]\ 

A backslash escapes special characters to 
suppress their special meaning. 

[\^\]] matches ^ 
or ] 

- (hyphen) except 
immediately after 
the opening [ 

Specifies a range of characters. (Specifies a 
hyphen if placed immediately after the 
opening [) 

[a-zA-Z0-9] 
matches any letter 
or digit 

^ (caret) 
immediately after 
the opening [ 

Negates the character class, causing it to 
match a single character not listed in the 
character class. (Specifies a caret if placed 
anywhere except after the opening [) 

[^a-d] matches x 
(any character 
except a, b, c or d) 

\d, \w and \s 

Shorthand character classes matching 
digits 0-9, word characters (letters and 
digits) and whitespace respectively. Can 
be used inside and outside character 
classes 

[\d\s] matches a 
character that is a 
digit or whitespace 

\D, \W and \S 
Negated versions of the above. Should be 
used only outside character classes. (Can 
be used inside, but that is confusing).) 

\D matches a 
character that is 
not a digit 

Dot 
Character Description Example 

. (dot) 

Matches any single character except line 
break characters \r and \n. Most regex 
flavors have an option to make the dot 
match line break characters too. 

. matches x or 
(almost) any other 
character 

 

Anchors 
Character Description Example 

^ (caret) 

Matches at the start of the string the regex pattern 
is applied to. Matches a position rather than a 
character. Most regex flavors have an option to 
make the caret match after line breaks (i.e. at the 
start of a line in a file) as well. 

^. matches a in 
abc\ndef. Also 
matches d in 
"multi-line" mode. 

$ (dollar) 

Matches at the end of the string the regex pattern 
is applied to. Matches a position rather than a 
character. Most regex flavors have an option to 
make the dollar match before line breaks (i.e. at 
the end of a line in a file) as well. Also matches 
before the very last line break if the string ends 
with a line break. 

.$ matches f in 
abc\ndef. Also 
matches c in 
"multi-line" mode. 
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\A 
Matches at the start of the string the regex pattern 
is applied to. Matches a position rather than a 
character. Never matches after line breaks. 

\A. matches a in 
abc 

\Z 

Matches at the end of the string the regex pattern 
is applied to. Matches a position rather than a 
character. Never matches before line breaks, 
except for the very last line break if the string 
ends with a line break. 

.\Z matches f in 
abc\ndef 

\z 
Matches at the end of the string the regex pattern 
is applied to. Matches a position rather than a 
character. Never matches before line breaks. 

.\z matches f in 
abc\ndef 

Word Boundaries 
Character Description Example 

\b 

Matches at the position between a word character 
(anything matched by \w) and a non-word 
character (anything matched by [^\w] or \W) as 
well as at the start and/or end of the string if the 
first and/or last characters in the string are word 
characters. 

.\b matches c in 
abc 

\B 

Matches at the position between two word 
characters (i.e the position between \w\w) as 
well as at the position between two non-word 
characters (i.e. \W\W). 

\B.\B matches b 
in abc 

Alternation 
Character Description Example 

| (pipe) 
Causes the regex engine to match either the part 
on the left side, or the part on the right side. Can 
be strung together into a series of options. 

abc|def|xyz 
matches abc, def 
or xyz 

| (pipe) 
The pipe has the lowest precedence of all 
operators. Use grouping to alternate only part of 
the regular expression. 

abc(def|xyz) 
matches abcdef or 
abcxyz 

Quantifiers 
Character Description Example 

? (question 
mark) 

Makes the preceding item optional. Greedy, so 
the optional item is included in the match if 
possible. 

abc? matches ab 
or abc 

?? Makes the preceding item optional. Lazy, so the abc?? matches ab 



Cirrus Configuration Management    

  150

optional item is excluded in the match if possible. 
This construct is often excluded from 
documentation because of its limited use. 

or abc 

* (star) 

Repeats the previous item zero or more times. 
Greedy, so as many items as possible will be 
matched before trying permutations with less 
matches of the preceding item, up to the point 
where the preceding item is not matched at all. 

".*" matches "def" 
"ghi" in abc "def" 
"ghi" jkl 

*? (lazy star) 

Repeats the previous item zero or more times. 
Lazy, so the engine first attempts to skip the 
previous item, before trying permutations with 
ever increasing matches of the preceding item. 

".*?" matches "def" 
in abc "def" "ghi" 
jkl 

+ (plus) 

Repeats the previous item once or more. Greedy, 
so as many items as possible will be matched 
before trying permutations with less matches of 
the preceding item, up to the point where the 
preceding item is matched only once. 

".+" matches "def" 
"ghi" in abc "def" 
"ghi" jkl 

+? (lazy 
plus) 

Repeats the previous item once or more. Lazy, so 
the engine first matches the previous item only 
once, before trying permutations with ever 
increasing matches of the preceding item. 

".+?" matches "def" 
in abc "def" "ghi" 
jkl 

{n} where n 
is an integer 
>= 1 

Repeats the previous item exactly n times. a{3} matches aaa 

{n,m} where 
n >= 1 and m 
>= n 

Repeats the previous item between n and m 
times. Greedy, so repeating m times is tried 
before reducing the repetition to n times. 

a{2,4} matches aa, 
aaa or aaaa 

{n,m}? 
where n >= 1 
and m >= n 

Repeats the previous item between n and m 
times. Lazy, so repeating n times is tried before 
increasing the repetition to m times. 

a{2,4}? matches 
aaaa, aaa or aa 

{n,} where n 
>= 1 

Repeats the previous item at least n times. 
Greedy, so as many items as possible will be 
matched before trying permutations with less 
matches of the preceding item, up to the point 
where the preceding item is matched only n 
times. 

a{2,} matches 
aaaaa in aaaaa 

{n,}? where n 
>= 1 

Repeats the previous item between n and m 
times. So the engine first matches the previous 
item n times, before trying permutations with 
ever increasing matches of the preceding item. 

a{2,}? matches aa 
in aaaaa 



 

   

Appendix E: Frequently Asked 
Questions 

Q Can I download more than one configuration file at a time? 

A Yes.  Select multiple Nodes from the Node List by using the Shift and 
Ctrl keys, or selecting a group.  Right-click and select Download 
Configs.  Choose the type of configuration to download and any After 
Download actions, and then click Download.  The configs will be 
downloaded from selected nodes simultaneously. 

By default, up to 25 simultaneous downloads can be allowed.  To change 
this, select Settings from the file menu, and then go to Config Transfers 
under the Configs category. 

Q Can I upload just a few lines of a configuration instead of the entire 
configuration file? 

A Yes.  To upload only one line or selection of lines, highlight the lines 
and then right-click and select Upload Selected Lines.  For more 
detailed instructions, please refer to Uploading Configs in Chapter 4: 
Managing Configs on page 43. 

Q Why do I receive a message prompting me to upgrade when I try to launch 
TraceRoute, IP Network Browser, or MIB Browser? 

A These tools are part of the SolarWinds Toolset packages.  These 
packages can be purchased and will need to be installed on the same 
system running Cirrus.  For information regarding the toolsets, please 
visit this link: http://www.solarwinds.net/Toolsets.htm 

Q How do I group Nodes so that I can roll out a config to part of the network? 

A Nodes can be grouped a number of different ways.  First, Nodes can be 
grouped by Node Group.  To assign a group to a Node, edit the 
Node’s details by double-clicking the Node in the Node List.  Then edit 
the Node Group field to assign the group.  The Node List can also be 
grouped by almost any other Node Detail such as Location.  To group 
the Node List by another category, right-click anywhere in the Node 
List and click Select Fields and Grouping.  Change the Grouping 
dropdown to the category desired and click OK to save the changes. 

http://www.solarwinds.net/Toolsets.htm
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Q What types of equipment does Cirrus work with? 

A Cirrus Configuration Management supports many types of network 
Nodes from many hardware vendors.  Device Command templates for 
Cisco, Foundry, Dell, HP Juniper, Motorola, Arris and many others are 
included. 

Q How do I integrate Cirrus with Orion? 

A As of Fall 2005, Cirrus does not directly integrate with Orion Network 
Performance Monitor.  SolarWinds plans to release a version of Cirrus 
in the future that will integrate with Orion and Orion’s website. 

Q Can I import nodes from Orion into Cirrus? 

A Yes.  Select Import Devices from the File menu to start the import 
process.  For detailed instructions on how to import Nodes from an 
Orion NPM database, please refer to Importing a List of Nodes in Chapter 
3: Managing Nodes on page 21. 

Q Can I import nodes from my Engineer’s Edition toolset to Cirrus? 

A Yes.  Select Import Devices from the File menu to start the import 
process.  For detailed instructions on how to import Nodes from an 
Engineer’s Edition database, please refer to Importing a List of Nodes in 
Chapter 3: Managing Nodes on page 21. 

Q What is the upgrade price from Professional Plus to Cirrus? 

A The toolsets and Cirrus are two separate packages.  An upgrade path 
from any of the toolsets is not available for Cirrus 

Q Can Cirrus use an Oracle database? 

A The Desktop version of Cirrus supports a Microsoft Access database 
format.  The Enterprise version of Cirrus supports both Microsoft 
Access and SQL database formats. 

Q Can Cirrus configure a router through the serial interface/console cable? 

A Routers and all other Nodes can only be configured through Telnet 
and SSH using Cirrus. 

Q What new features are on the roadmap for Cirrus? 
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A SolarWinds plans to integrate Cirrus with Orion NPM and the Orion 
Syslog Server in the near future.  Additional features such as policy 
control and additional device template support are just some of the 
additional functions SolarWinds is planning to add. 

Q Can Cirrus run on the same server as Orion? 

A Yes.  Cirrus is designed to be fully compatible with all SolarWinds 
software including Orion NPM. 

Q Can Cirrus share a database with Orion? 

A The Cirrus and Orion database structures are significantly different.  
However, Nodes can easily be imported from the Orion NPM 
database.  For detailed instructions on how to import Nodes from an 
Orion NPM database, please refer to Importing a List of Nodes in Chapter 
3: Managing Nodes on page 21. 

Q Can the Cirrus database reside on the same SQL Server as Orion’s? 

A Yes.  Cirrus and Orion both have the ability to use remote databases.  
This means that the same SQL server can host both the Orion and 
Cirrus databases assuming the server is capable of handling the load of 
multiple databases. 

Q Can Cirrus run on UNIX? 

A SolarWinds software is designed to run exclusively on Microsoft 
Windows platforms. 

Q My domain password changed, now my jobs won’t run and there is 
nothing in the job log, what do I need to do? 

A To reassign the new password to all jobs, open the New/Open Database 
Wizard from the File menu, select Continue Using the Current Database, 
and click Next.  Continue clicking Next until the Scheduled Job 
Authentication settings are displayed.  Type the new username and 
password, and then click Set Username and Password to update the 
changes.





 

   

Appendix F: Glossary 
Access Point (AP) A Network Node that interconnects a wireless radio 

network to a wired LAN (Local Area Network). 

Bandwidth In digital communications, the rate at which data is 
communicated (usually in bits per second). 

Community string The “password” required for an SNMP client to request 
MIB information from an SNMP server. 

Config Short for configuration file.  An Industry standard term 
referring to the configuration of a router, switch, firewall, or 
other network Node. 

Config Snippet A string of text that can be saved to a file allowing the user 
to merge sections of configs with ease.  Config Snippets can 
be used to edit an existing config, or can even be uploaded 
directly to a Node or group of Nodes. 

Custom Property Additional fields (country, building, asset tag, serial 
number, etc.) that can be defined and stored in the Cirrus 
database.  Custom Properties are used to help identify and 
group like Nodes. 

DNS An acronym for Domain Name Server.  A system of 
computers that convert domain names into IP addresses. 

Event An unsolicited communication from a hardware device to 
an application driver.  Events are generally attention-getting 
messages, allowing a person or process to know when a 
task is complete or when an external event occurs. 

ICMP An acronym for Internet Control Message Protocol.  A 
network-layer Internet protocol that provides message 
packets to report errors and other information relevant to IP 
packet processing. 

Interface A port or logical connection on a node. 

MAC Address An abbreviation for Medium Access Control Address.  A 
48-bit unique number administered by the IEEE and 
assigned to LAN cards. 

Macro A statement in software code that is expanded into one or 
more identifiers or statements and can consist also of one or 
more parameters. 
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MIB An acronym for Management Information Base.  A MIB is a 
database of network performance information that is stored 
on a network Node for access by network management 
software. 

Node Any device with an IP address; a network device that is 
polled. A Node may contain many elements.  An example 
of a Node would be a router or network server. 

Node List In the Cirrus Configuration Management application, the 
left-most pane of the program window that contains an 
expandable list of Nodes and configuration files. 

PING To test whether a particular network destination is online. 
By bouncing a “signal” off a specified IP destination 
address. 

Purge To remove records from a database. 

SNMP An acronym for Simple Network Management Protocol. An 
IP-based application layer protocol that is the industry 
standard way that network Nodes communicate with 
network management systems. 

SSH An Acronym for Secure Shell.  A UNIX-based command 
interface and protocol for securely getting access to a remote 
computer.  Network administrators use it to control Web 
and other kinds of servers remotely. 

Telnet A program that connects to other computers on the Internet.  
The process by which a person using one computer can sign 
on to a computer in another city, state or country. 

Most definitions included in this Glossary were obtained from Newton’s Telecom 
Dictionary by Harry Newton and published by CMP Books. 
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